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The Vancouver Community Coalition Against Prohibition and Overdose (VAN CCAPO) Street Degree began as a peer 
informed and peer driven education collaboration between Vancouver Coastal Health (VCH), the Portland Hotel Society, 
the Tenant Overdose Response Organizers, the Western Aboriginal Harm Reduction Society, DUDES Club, and the 
Coalition of Peers Dismantling the Drug War, with the goal of furthering the work being done by peers in the domains of 
overdose prevention, safe supply, housing, food security, and outreach. The VAN CCAPO Street Degree has peers engage 
and take leadership in content development and thereby addresses inequality and recreates the hierarchy of expertise 
while incorporating the wealth of knowledge found in lived experience. This helps break down barriers, decrease 
discrimination, and empowers peers as pivotal members of our community. Peers have stepped up in both the design 
and ongoing feedback of this education process as well as in the facilitation of courses. This education series could not 
happen without the contribution of peers, their knowledge, and their skills.

Many peers working in Vancouver’s Downtown Eastside (DTES) have expressed their desire to be involved, give back to 
their communities, and take on leadership in their roles. Peers have also stated many are already doing unpaid work to 
assist with the needs of their community, and are often at different levels of learning – this curriculum was developed 
so that peers could build skills, self-esteem, help participate in educating others, and improve skills for employability. 
This curriculum was inspired by foundational work done by PHS, the DTES SRO-C, WAHRS, and Insite. Ultimately the core 
objective of the “VAN CCAPO Street Degree” is wider acceptance, acknowledgement and legitimization of the knowledge 
and work done by peers in Vancouver’s DTES.

VAN CCAPO: Street Degree

Purpose: To empower peers working in Vancouver’s DTES through education.

Vision: A collaborative education lab created for, and with, peers, as we work together to reduce the harms of 
colonialism, the war on drugs, and gentrification.

What: This education lab is a forum for high-quality, peer-informed, education delivered within a culturally sensitive 
and trauma informed framework. Participants will be certified in modules so that they can step up as leaders in their 
work, and when they complete up to 10 courses, students will achieve a “VAN CCAPO Street Degree” which can be taken 
with a variety of specializations, or generally. To achieve a specialized degree, participants will have to take 5 courses in 
a single specialization. Participants are also welcome to suggest additional courses which can be incorporated into the 
curriculum.

Target Audience: Peers who work in Vancouver’s DTES with other DTES residents. Including those living in SROs, people 
accessing overdose prevention services, etc. 

Educational Approach: These interactive modules can be delivered by peers, and may be cofacilitated with educators, 
and/or community and organizational members. Sessions are often facilitated in an informal participatory style to allow 
for questions, group discussions, and peer informed topics while weaving a culture of respect and putting people through 
the learning process. Capacity building is a top priority.



Objectives

By taking part in the educational modules, participants should be able to:

1. Strengthen relationships of solidarity in Vancouver’s DTES between those living and working in a variety of situations 
with various stakeholders.

2. Learn foundational skills to be able to work in overdose prevention, outreach, in private SROs, etc. and respond to 
situations safely.

3. Understand the key elements of mental and physical well being, reducing stigma, creating cultural safety, working 
within a strengths based framework, and supporting folks and their unique needs when connecting with services.

4. Be able to identify and refer folks to integrated health services and become more integrated into the continuum of 
care in the DTES.

5. Translate learning into action by helping to co-facilitate modules with support, and be able to set up for success in 
teaching and translating knowledge back to their communities.

Health, Harm Reduction, and Overdose Prevention
1.	 Overdose Response Basics
2.	 COVID-19 and OD Response
3.	 Advanced Overdose Management
4.	 Train the Trainer and Naloxone Distribution
5.	 Safer Self Injection 1
6.	 Safer Self Injection 2
7.	 Let’s Talk About Drugs
8.	 Community Resources
9.	 COVID-19 and PPE

Relational Skills
10.	 Managing Extreme Situations (2 Modules)
11.	 Preventing Burnout
12.	 Boundary Setting (Collective Resiliency) 
13.	 Reducing Stigma
14.	 Strength Based Care (Trauma Informed Care)
15.	 Communication Skills
16.	 Facilitation Skills

Computer Literacy
17.	 Indesign (3 Part Course)
18.	 Social Media*

Password: socialmedia2020!

SRO Degree
19.	 Common Maintenance Problems
20.	 Writing a Letter to your Landlord
21.	 City and Inspections
22.	 Take your Landlord to Housing Court
23.	 Door Knocking and Landlord Backlash
24.	 Taking Leadership and Illegal Rent Increases

MODULES TO BE DEVELOPED

Health, Harm Reduction, and Overdose Prevention
•	 Wound care 
•	 Safe Supply
•	 Drug Checking

Computer Literacy
•	 Use of dark web

SRO-Degree
•	 Facilitate a Meeting and Rent Reduction
•	 Spotlight on Legal Advocacy

 History 
•	 History of DTES
•	 History of Chinatown
•	 History of Prohibition
•	 History of the SRO-C
•	 History of Colonization

Decolonizing Practice
•	 Cultural humility 
•	 Cultural safety

COURSES CURRENTLY OFFERED

*These modules require further development 
and are only available digitally. 
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G L O S S A R Y  O F  T E R M S

For facilitators who are less familiar with drug use or are from a region outside Metro Vancouver.

Bang			   An injection of drugs.
Cooker			  A small metal bowl with a handle that is used to cook or prepare drugs for injection. 
Dilly/dillies		  Dilaudid, a prescription opiate that is resold on the street illegally.
“Doctor”		  When another person helps someone inject.
Dope			   Usually means heroin, but may also refer to crack cocaine or other drugs.
Dopesick		  Experiencing opiate withdrawal. 
Down			   Opiates - could be heroin, fentanyl or a combination.
Flap			   A small paper envelope of drugs. The size of a flap is not standardized.
Fix (fixed, fixing)	 Injection of drugs.
GHB			   Gamma-Hydroxybutyric acid, could be used as a date-rape drug or as a rave party scene 		
			   drug used to get high. 
Goofballs		  Heroin and crystal meth done at the same time.
Jib			   Crystal meth.
Jugging		  Injecting into jugular vein.
Mouthpiece		  A piece of plastic tubing that can be inserted onto the mouth part of a pipe (for crack or 
			   crystal meth) that can be removed so that another person can use the same pipe with
			   their own mouthpiece. 
Pipes			   There are two kinds: (1) Crack/rock (2) Crystal meth. Crack pipes are straight tubes of
			   glass while crystal meth pipes have a small bowl on one end.
Point			   0.1g of illicit drugs (e.g. “I did 2 points of crystal” = using 0.2g of crystal meth)
Powder		  Powder cocaine.
Push sticks		  Wooden sticks (like a bbq skewer or chopstick) that are used to push crack into pipes.
Red zones		  Aka “No go” zones. Determined by the court/justice system, these are restrictions for 		
			   entering certain areas. These may be as small as a specific store or housing, but can also 		
			   be as large as the entire Downtown Eastside.
Rig			   Needles used for injecting drugs.
Rock			   Crack cocaine.
Shoot up		  Inject drugs.
Side 			   Crystal meth. 
Speed			   Crystal meth.
Speedballs		  Heroin and powder cocaine done at the same time.
Smash			   An injection of drugs.
Tie/s			   Generally a wide, flat, blue piece of elastic that is used to tie off the area above the 
			   elbow to facilitate finding a vein for injection. 
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Total Time:

65 Minutes

HANDOUTS:

•	 Overdose Survival Guide Pamphlet

•	 SAVE ME Flow Chart

Overdose Response

1.	 Prevention

•	 Factors that can increase or decrease the risk of an overdose.

2.	 Opiates vs. stimulants

•	 How to recognize depressant, opioid, and stimulant overdoses.

•	 Benzo overdoses, and psychedelic overdoses.

3.	 SAVE ME steps, naloxone practice

•	 How to respond to an overdose.

4.	 Breathing mask types and styles.

5.	 Naloxone at the organization: storage, refills.

6.	 How to support the person after they regain consciousness.

OVERDOSE RESPONSE BASICS

Topics

P
P

P

Equipment 
& Materials:

Naloxone Kits
Breathing Masks
Photocopies of 

handouts
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PREVENTION: 

Factors that can increase or decrease the risk of overdose:
•	 Overdose is most common when:
•	  Your tolerance is lower: you took a break, were in detox/treatment or 

jail, or you are new to use
•	  You have been sick, tired, run down, dehydrated or have liver issues
•	  You mix drugs: prescribed or not, legal or illegal
•	  The drugs are stronger than you are used to: changes in supply, 

dealer, or town

To prevent overdose:
•	 Know your health status and your tolerance 
•	 Do not mix drugs and alcohol. If you do mix, choose to use drugs 

before alcohol
•	 Be aware: using drugs while on prescribed medications can increase 

overdose risk
•	 Don’t use alone. Leave door unlocked. Tell someone to check on you
•	 Do testers to check strength. Use less. Pace yourself 
•	 Talk to an experienced person or a trusted healthcare provider about 

reducing risk
•	 Know CPR and get trained on giving naloxone
•	 Choose a safer route of taking drugs

1 Section Time

10 Minutes

Presenter(s)

_________
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OPIATES VS. STIMULANTS: 

OPIOIDS / DEPRESSANTS (e.g., opiods: morphine, dilaudid, heroin, fentanyl)

Feels and looks like:
• Person cannot stay awake
• Can’t talk or walk
• Slow or no pulse
• Slow or no breathing, gurgling
• Skin looks pale or blue, feels cold
• Pupils are pinned or eyes rolled back
• Vomiting
• Body is limp
• No response to noise or knuckles being rubbed hard on the breast bone

2

STIMULANTS (e.g., cocaine, methamphetamine, ecstasy)

Feels and looks like:
• Fast pulse or no pulse
• Short of breath
• Body is hot/sweaty, or hot/dry
• Confusion, hallucinations, unconscious
• Clenched jaw
• Shaky
• Chest pain
• Seizures
• Vomiting
• Cannot talk or walk

BENZOS

Feels and looks like:
•	 drowsiness
•	 dizziness
•	 memory problems
•	 slurred speech
•	 blurred vision
•	 shallow breathing
•	 clammy skin
•	 dilated pupils
•	 a weak and rapid heartbeat
•	 coma or death in cases of overdose

Feels and looks like:
•	Sweating
•	Nausea
•	Dilated pupils
•	Rapid heartbeat

•	Dry mouth
•	Tremors
•	Insomnia
•	Blurred vision
•	Weakness

•	A distorted sense of 
time

•	Visual hallucinations
•	Mixed senses 
•	Raised body 

temperature.

•	Intensified sense of 
smells and noises

•	A sense of a mystical 
experience

Section Time

10 Minutes

Presenter(s)

_________

PSYCHEDELICS (e.g., LSD, psilocybin/mushrooms)
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SAVE ME steps and NALOXONE PRACTICE:

Responding to an Opiate Overdose

 
Can you wake them up? If not, call 911

Make sure there’s nothing in their mouth that stops 
them from breathing.

Breathe for them. (Plug nose, tilt head back, and give 
1 breath every 5 secs).

Are they any better?

Are you trained to give naloxone? 
Inject naloxone into a muscle.

evaluate and support Is the person breathing on their 
own?

If they’re not awake in 5min, another dose is needed. 
Tell the person not to use any more drugs right now – 
wait at least 2 hours.

3
stimulation

airway

ventilate

evaluate

muscular 
injection

evaluate & 
support

•	 Demonstrate the overdose response steps using a practice naloxone kit

•	 Hands-on practice in pairs

Section Time

15 Minutes

Presenter(s)

_________
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BREATHING MASKS - Types and Styles

There are two main types of barrier masks for giving breaths:

1.	 A flat plastic barrier that lays across the person’s mouth and nose. It 
conforms to the face and allows the rescuer to blow through a hole in 
the middle. The hole has either a one-way valve or a filter to protect 
the rescuer, depending on the brand.

2.	 A mask shaped like a pear that fits over the mouth and nose. With 
proper technique, it seals onto the face. The rescuer blows through a 
one-way valve at the top to provide rescue breaths.

Show examples of the masks and how to use them

4

ASSESSMENT: ARE THEY EXPERIENCING  A  OR  B ?

A  MENTAL DISTRESS/OVERAMP

Associated with: sleep deprivation, crashing, anxiety, 
paranoia. If a person is conscious, and you are sure 
this is not medical in nature, they may just need 
support and rest. Call Poison Control to help assess.

WHAT TO DO:

• Keep calm. Stay with person. Use their name

• Give water or fluid with electrolytes. Do not 
overhydrate

• Place cool, wet cloths under: armpits, back of neck, 
and head

• Open a window for fresh air

• Get them comfortable. Move away from activity

• If aggressive/ paranoid suggest they close their 
eyes, give

person space

• Encourage person not to take any other substances

• Doctor may treat agitation and paranoia with a 
benzodiazepine

If you’re not comfortable with the situation, call 911.

B  PHYSICAL DISTRESS/ACUTE STIMULANT TOXICITY

Medical attention is required immediately if person 
has:

• Jerking or rigid limbs

• Rapidly escalating body temperature and pulse

• In and out of consciousness

• Severe: headache, sweating, agitation

• Chest pains

WHAT TO DO:

• Call 911

• Stay with person

• Keep person: conscious, hydrated, calm

• If heart has stopped do ‘hands-only’ CPR

• Tell medical professionals as much as possible so 
they can give the right treatment to prevent organ 
damage and death

Responding to a Stimulant Overdose

 

 

Section Time

10 Minutes

Presenter(s)

_________
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NALOXONE AT THE ORGANIZATION: storage, refills

General Notes about Supplies (from the BCCDC)

Use older supplies first. Remember: First In, First Out (FIFO)

Store naloxone at room temperature and away from light.

To avoid disruption of services, plan ahead and place an order before you 
run out of stock. Orders take 10 days to process.

How Much to Order

BCCDC suggests that sites order on a monthly basis to avoid a surplus of 
stock that may go unused or expired. High volume sites can order weekly 
as needed.

Naloxone has a shelf-life of ~2 years. To ensure that clients are given 
naloxone kits that have the longest possible shelf-life, BCCDC encourage 
ssites to order enough supplies to distribute for 2-3 months.

Typical order sizes:
o Smaller sites: 20 kits  
o Larger sites: 50 kits  
o New sites: 10 kits

Review BCCDC Ordering Form

5

HOW TO SUPPORT THE PERSON AFTER THEY REGAIN CONSCIOUSNESS

Naloxone’s effect lasts for about 30 to 90 minutes in the body. Because 
most opioids last longer than that, the naloxone may wear off before the 
effects of the opioids wear off and the person might go into an overdose 
again. 

If the person uses more heroin or opioids when there is still naloxone in 
the system, he or she may not feel it at all – naloxone will knock it out of 
the opioid receptors and the person will have wasted their drugs.

The likelihood of overdosing again depends on several things including:
•	 How much drug was used in the first place and the half-life of the 
drug(s) taken
•	 How well the liver works to process things; and
•	 If the person uses again.

If the person cannot walk and talk well after waking up, then it is very 
important that they are taken to the hospital. If possible, stay with the 
person for several hours keeping them awake.

6

Section Time

10 Minutes

Presenter(s)

_________

Section Time

10 Minutes

Presenter(s)

_________
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TAKE HOME NALOXONE : SUPPLY ORDER FORM
Registered Sites Only – Supplies not intended for use in the workplace  

E-mail form to naloxone@bccdc.ca if you don’t have e-mail, please fax to 604-707-2516

E- mail naloxone@bccdc.ca for queries, follow-ups or changes to orders.
Please allow 10 working days for delivery and plan ahead to avoid shortages. 

 
 
 

 
INVENTORY COUNT (NUMBER OF THN KITS ON SITE):                   Kits 
 
 
Site #    Site Name: Date Submitted:

Contact Name: Delivery Days & 
Times:

 

Shipping Address:
Phone/Email:

 
Products Contents Unit of Issue Quantity Ordered

 
Completely
Assembled

THN Kit

1 x Black case 
3 x Naloxone, 0.4 mg/mL, 1 mL ampoule 
3 x Vanish Point® 3 mL syringe 1 x  
1 x  Amber medication bottle with label 
3 x Plastic ampoule breakers  
1 x Pair of non-latex gloves  
3 x Alcohol swabs 
1 x Individual breathing mask in pouch 

 
 
 
 
 
 

1 kit

 
 
 
 

  Kits
 

 
 

Naloxone 
Replacement Bottles 

(to refill used kits)

3 x Naloxone, 0.4 mg/mL, 1 mL ampoule 
1 x Amber medication bottle with label  
3 x Plastic ampoule breakers 

   Naloxone expiry label on bottle  

 
 
 

1 bottle

 

 
  Bottles

 
(Kit Refills Only)

 
 
 
 

Mock Kit
(for training purposes)

1 x Black Case 
3 x Water ampoules, 1 mL 
3 x Vanish Point® 3 mL syringe  
1 x Amber medication bottle with label  
3 x Plastic ampoule breakers 
1 x Pair of non-latex gloves  
3 x Alcohol swabs 
1 x Individual breathing mask in pouch 
 
 

 
 
 
 
 

1 kit

 
 
 
 

  Kits
 

maximum: 5 

  Circle Quantity Required 
Loose Supplies 

(for replacement kits or 
training purposes) 

Vanish Point® 3 mL syringe 100        200        300 
Plastic ampoule breakers  100        200        300 

Water ampoules, 1 mL                              100         200        300 
Individual breathing mask in pouch 
(Available only for kit refills ONLY, quantity ordered should match 

quantity of ‘Naloxone Replacement Bottles’ ordered)  

 

OD Survival Guide Brochure – English  50    100    150    200    250    300 
Box non-latex gloves  

Good Samaritan Drug Overdose Act Wallet Cards – 
English  50    100    150    200    250    300 

This form is only for approved sites participating in the Take Home Naloxone program.  
Page 1 of 2 
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Naloxone Training Videos are available for viewing under the Participant Training resources found here: 
http://towardtheheart.com/naloxone/. These videos may also be downloaded directly from the following Vimeo links: 

• Naloxone Saves Lives - https://vimeo.com/164669763  
• Naloxone Wakes You Up - https://vimeo.com/hellocoolworld/review/180116125/5bbda65390  

 
 

Take Home Naloxone Supply Ordering at the BCCDC 
 

To receive Take Home Naloxone supplies, sites must be registered in the program.  To learn more, visit 
http://towardtheheart.com/naloxone/.  

 

General Notes about Supplies 
 

• Any changes to supplies will be posted on towardtheheart.com and made to the Supply Requisition Form 
• Use older supplies first. Remember: First In, First Out (FIFO) 
• Naloxone has shelf-life of ~2 years. Check the expiry of your kits before dispensing to clients 
• Naloxone within 3 months of expiration should not be dispensed to clients. Order new naloxone for replacement 

 
BCCDC Weekly Processing 

 
• To order supplies, fill out the attached Take Home Naloxone Supply Requisition Form and fax it to 604-707-2516. 
• For timely processing, we recommend submitting your order by Wednesday. All orders received after the cut-off 

time of 11:59pm on Wednesday will be processed the following week and delivery will be delayed. 
• The supplies will be packaged at the BCCDC pharmacy during the week following the placement of the order. The 

packages will then be shipped out to the site. Delivery time is expected to be 10 working days. 
• To avoid disruption of services, plan ahead and place an order before you run out of stock. 
• Please ensure the THN program coordinator is informed of changes to contact information to avoid the requisition 

form from not being processed. 
 
How Much to Order 

 
• We suggest that sites order on a monthly basis to avoid a surplus of stock that may go unused or expired. For high 

volume sites, we recommend ordering weekly as needed. 
• Naloxone has a shelf-life of ~2 years. To ensure that clients are given naloxone kits that have the longest possible 

shelf-life, we encourage sites to order enough supplies to distribute for 2-3 months. 
• Typical order sizes: 

o Smaller sites: 20 kits 
o Larger sites: 50 kits 
o New sites: 10 kits 

• BCCDC staff may need to follow up with the sites placing unusually large or small orders 
• We recommend ordering 1 syringe, 1 water ampoule and 1 OD survival guide brochure for every kit ordered so 

staff can train clients. Sites training a large number of staff or family/friends of clients should order additional 
training supplies as needed. Smaller sites may order smaller quantities of loose supplies. 

 
Receiving Supplies and Questions 

 
• Please check your order upon receipt. Ensure that you receive the correct quantity and that the supplies reach you 

in good condition. If you notice any discrepancy, or have any questions or concerns about the distribution of take 
home naloxone supplies, please email naloxone@bccdc.ca  

Page 2 of 2 
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1.	 Stages of an Opiate Overdose

2.	 Complex Overdoses

•	 Benzo overdoses

•	 Psychedelic overdoses

•	 Alcohol

•	 Chest Wall Rigidity

3.	 Airway management

4.	  Bag Valve mask introduction and hands on practice

ADVANCED OVERDOSE MANAGEMENT

Topics

Total Time:

60 Minutes

STAGES OF AN OPIATE OVERDOSE: 

Review:

1.	 Drowsiness 

2.	 Nodding (intermittently falling asleep) 

3.	 Nodding with respiratory rate less then ten breaths per minute 

4.	 Unresponsive

Ask the group: Peer experiences (group discussion)

1 Section Time

10 Minutes

Presenter(s)

_________

Equipment 
& Materials:

Bag Valve Mask
Photocopies of 

handouts
Computer
ProjectorP

P

P

P
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COMPLEX OVERDOSES:

Benzo overdoses

•	 look like opioid overdoses 

•	 Response is similar to an opioid overdose (SAVE ME steps) 

•	 Naloxone has no effect on non-opiod overdoses HOWEVER, if 
there are any opioids in the person’s system, it will temporarily 
take opioids out 
of the picture 

•	 Administering 
naloxone will not be 
harmful (it will have no 
effect)

Psychedelic overdoses
When someone takes too much of a 
psychedelic, they may experience terrifying 
hallucinations, but will not likely need a medical 
response

LSD, for example, has no known lethal dose and 
technically can’t kill a person.

Supporting someone who is having a negative response to 
psychadelics is similar to 
supporting someone 
having a psychological 
crisis.

Be a calm, supportive presence:
•	 Support where they are at (but 

avoid guiding)
o Let the person’s unfolding 
experience be the guide.

•	 Talk them through an event, not down
o Explore distressing issues as they emerge 
o Help the person connect with what they are 
feeling

2 Section Time

20 Minutes

Presenter(s)

_________
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COMPLEX OVERDOSES continued:

Alcohol

An alcohol overdose occurs when there is so much alcohol in the 
bloodstream that the brain starts to fail to control breathing, heart 
rate, and body temperature.

Be aware that a person who has passed out from drinking alcohol 
can die. Cold showers, hot coffee, and walking do not reverse the 
effects of alcohol overdose and could actually make things worse.

While waiting for medical help to arrive:

•	 Be prepared to provide information to the responders, 
including the type and amount of alcohol the person drank; other drugs he or 
she took, if known; and any health information that you know about the 
person, such as medications currently taking, allergies to medications, 
and any existing health conditions.

•	 Do not leave an intoxicated person alone, as he or she is at risk 
of getting injured from falling or choking. Keep the person on the 
ground in a sitting or partially upright position rather than in a chair.

•	 Help a person who is vomiting. Have him or her lean forward to 
prevent choking. If a person is unconscious or lying down, roll him or 
her onto one side with an ear toward the ground to prevent choking.

Chest wall rigidity or “wooden chest syndrome” can happen from rapid 
injection of high doses of fentanyl. 

Risks include: 
•	 jaw clenching interfering with giving breaths or inserting an airway 
•	 chest or torso rigidity interfering with breathing
•	 fist clenching and finger stiffness interfering with oxygen saturation 
monitors 

Risk factors: 
•	 age
•	 health conditions including Parkinson’s, neurologic or metabolic 

conditions
•	 some medications, including some antidepressants

Chest Wall Rigidity will usually respond quickly to naloxone.

Review Towards the Heart handout 

confusion

difficulty remaining 
conscious

vomiting, seizure

trouble breathing

slow heart rate

clammy skin

dulled responses 
such as no gag 
reflex (which 

prevents choking)

extremely low body 
temperature

Symptoms of an Alcohol 
 Overdose

 
If someone 

has overdosed on 
non-beverage alcohol 

(like rubbing alcohol or 
hand sanitizer) do NOT 

encourge them to vomit 
as it can do more 

harm.



VAN CCAPO: Street Degree                                                                 Health, Harm Reduction & Overdose Prevention 

Advanced Overdose Management | Pg 23

AIRWAY MANAGEMENT: 

In order to effectively give someone breaths or oxygen, their airway 
needs to be clear. If someone is fuly unresponsive their tongue can lose 
muscle control and block their windpipe. Their breathing may also be 
obstructed by liquid like blood or vomit. 

Airway Maneuvers:

Ask the group: What are the first steps to establish an open airway?

Head-tilt chin-lift — the main maneuver used if there is no concern the 
person has a neck injury. 
Jaw-thrust maneuver — used when a neck or spine injury is a concern.

Oropharyngeal Airway (OPA)

OPAs can help keep an airway open.

•	 Can be used when someone is unresponsive with an 
absent gag reflex

•	 Cannot be used when someone has an intact gag reflex

•	 Pros: Simple, non-invasive, easy to place

•	 Cons: Risk of pushing tongue back and making obstruction 
worse. Risk of vomiting

OPAs come in multiple sizes. Demonstrate method for 
chosing the correct size.

Steps to inserting:

1) Turn the OPA upsidedown

2) Insert into the mouth

3) Rotate into position

4) Make sure it is located correctly

Watch 2 minute demonstration video: https://
www.youtube.com/watch?v=Hzc_T4QBp4E

3 Section Time

15 Minutes

Presenter(s)

_________

Potential hazards of using the OPA:

•	 Pushing the tongue backwards and 
making the airway obstruction worse

•	 Using an incorrectly-sized device: too 
small a device is ineffective and can be 
lost down the throat; too large a device 
can press against the back of the throat 
and obstruct the larynx

•	 Pinching the tongue or lips (usually the 
lower lip) between the airway and the 
teeth

•	 Using the device in a patient who is 
not totally unresponsive and possibly 
inducing vomiting. If this happens 
remove the OPA immediately.*If you don’t have a projector and computer to show 

the video, then distribute and review the handout on 
OPA insertion
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BAG VALVE AND HANDS ON PRACTICE: 

Ask the group: what are some reasons you may use a Bag Valve Mask?

• A bag valve mask (BVM) is used to force air into a person’s lungs.

• BVMs can deliver up to 100% oxygen to people when attached to an 
oxygen cylinder and only 21% when not attached.

• We use BVMs when we need to assist with breathing.

Demonstrate proper use of Bag Valve Mask and have participants handle 
the mask and position it correctly.

STEPS:

1. Open the airway with the head tilt-chin lift or modified jaw thrust. 

2. Tightly secure the proper size mask over the mouth and nose.

3. Gently ventilate the person (when you breath, squeeze the BVM).

Here are a few things to avoid:

•	 Not properly positioning the airway. Failing to open the airway, or 
not maintaining an open airway once it has been positioned doesn’t 
allow air into the lungs.

•	 Pushing the mask into the face. Pushing the mask down on the 
face, instead of lifting the jaw into the mask, pushes the tongue 
against the back of the throat and obstructs the airway. Together with 
the mask on the face, this suffocates the person.

•	 Not maintaining an effective seal. BVM ventilation is recognized as 
a two-rescuer skill. Only rescuers with exceptionally large hands 
can effectively maintain an open airway, displace the jaw into the 
mask and maintain a proper mask seal with a single hand. For most 
rescuers, two hands are needed on the mask to accomplish all of 
these tasks simultaneously and effectively.w

•	 Over-ventilating and hyperventilating. Giving too much volume or 
going too fast could push air into the stomach, resulting in gastric 
insufflation. This could lead to vomiting and airway obstruction.

4 Section 
Time

15 Minutes

Presenter(s)

_________



Fentanyl-induced muscle rigidity, also known as �chest wall rigidity� or �wooden chest syndrome� is a complication of 
intravenous injection of fentanyl that is known amongst hospital populations receiving anesthesia.  Symptoms happen 
after rapid injection of high doses of fentanyl, and characterized by jaw clenching interfering with oral airway insertion, 
chest or torso rigidity interfering with ventilation, and fist clenching and finger stiffness interfering with oxygen saturation 
monitors. Fentanyl-induced muscle rigidity is being reported in people using illicit drugs containing fentanyl; however the 
literature, community members, Insite, and emergency health services report the rigidity responds quickly to naloxone. 
The risk of rigidity may be increased by age, health conditions, or medications including Parkinson’s, neurologic or 
metabolic conditions, and some antidepressants. 

 
(and other Unusual Overdose Presentations)

F�� ���� ����������� ������ ����������������������

FENTANYL-INDUCED MUSCLE RIGIDITY

Last updated: 2018-10-02

RECOMMENDATIONS FOR BY-STANDERS WITNESSING FENTANYL-
INDUCED MUSCLE RIGIDITY
The goal for by-stander overdose response is to 'rescue' the person having an overdose until professional (paramedic) 
assistance arrives.  In these situations it is important to remember that immediate administration of larger doses of 
naloxone are NOT recommended as it may cause vomiting due to withdrawal. This is dangerous in the presence of rigidity 
as it could compromise the person’s airway and ability to receive oxygen. 

RECOMMENDATIONS

1)     Call 911 immediately
 
2)     Attempt to ventilate the person with the technique you are most comfortable using. 
            i.   If airway support equipment and trained individuals are available, use a two person bag-valve mask technique* 
            ii.  Otherwise, give breaths as possible and use barrier device if available.
 
3)     Administer naloxone - Do not delay. 
        Naloxone should be administered in overdoses with muscle rigidity as follows:
 
  A) Muscle rigidity where ventilation is inadequate:
   i.    Immediately administer 0.4 mg naloxone by intramuscular injection. 
   ii.    If the person does not respond sufficiently, administer additional naloxone doses every 2 minutes. 
   iii.   The following dosing schedule can be followed where higher dose naloxone is available: 0.8mg, 2mg, 4mg.
 
  B) Muscle rigidity where ventilation is adequate (i.e. ventilation is adequately maintained, particularly when oxygen  
 monitoring is available)          
  Naloxone can be given more conservatively to lower the risk of inducing withdrawal and vomiting:   
 
    i.     Immediately administer 0.4 mg naloxone by intramuscular injection. 
    ii.    If person does not respond sufficiently, administer additional naloxone doses every 3-5 minutes.
    iii.   The following dosing schedule can be followed if needed where higher dose naloxone and medical support is 
available: 0.8mg, 2mg,4mg. 
 
4)    If the person loses their pulse: perform chest compressions, assist ventilation and administer 2 mg of naloxone 
immediately if available.
 
*A two person bagging technique: one rescuer uses both hands to form a tight seal with the mask around the mouth and nose of 
the patient and a second rescuer operates the bag.
 

Overdose  Resources

Fentanyl-Induced Muscle Rigidity 

1-3

2-5

2,3

5-7



�or more information �isit: ����to�ardt�e�eart�com

Unusual movement of the arms and legs
Seizures 
Delirium 
Staring gaze 
Walking or Awake overdoses where the person is able to follow simple commands but is still not getting enough  
oxygen (e.g. blue lips, greyish colouring, cool skin) 
Decorticate posturing (inwardly flexed at wrists, elbows, and feet) 
Slowed heart rate or irregular heart rate
Vomiting 

OTHER UNUSUAL OR COMPLEX OVERDOSE PRESENTATIONS

Last updated: 2018-10-09

Fentanyl-induced muscle rigidity and other unusual overdose presentations may be related to higher doses of fentanyl 
which are administered rapidly

Safer drug use recommendations

Have a buddy or use overdose prevention sites. Make sure someone can call for help
Start low and go slow. Drugs might be stronger than you realize
Have an overdose plan. Carry Naloxone
Beware of mixing. Avoid using alcohol. Prescription drugs increase overdose risk
Take care of yourself. Use less when having health issues or haven’t used for a while.

Please be safe:

1 Dimitriou V, Zogogiannis I, Wambi F, Tawfeeq N, Koumi A, Geldhof G.Impossible mask ventilation after unusually low  dose fentanyl-induced muscle rigidity in a patient with essential 
tremor: a case report and review of the literature. Middle East J Anaesthesiol. 2014 Oct;22(6):619-22.  
2 Ahmad M, Raza T. �Jaws of steel� after very low dose of fentanyl during prebronchoscopy sedation. J Bronchology INterv Pulmonol 2017 Jan;24(1):e9-e10.
3 Coruh B, Tonelli MR, Park DR. Fentanyl-induced chest wall rigidity. Chest 2013 Apr;143(4):1145-6. 
4 Burns G, DeRienz RT, Baker DD, Casavant M, Spiller HA. Could chest wall rigidity be a factor in rapid death from illicit fentanyl abuse? Clin Toxicol (Phila) 2016 Jun;54(5):420-3. 
5 Buxton, J.A., Gauthier, T., Mai-Lei Woo, K. & Goodwin, J. (2018). A 52-year-old man with fentanyl-induced muscle rigidity. Canadian Medical Association Journal, 190(17). p. E539-
E541
6 Zesiewicz TA, Hauser RA, Freeman A, Sullivan KL, Miller AM, Hallim T.Fentanyl-induced bradykinesia and rigidity after deep brain stimulation in a patient with Parkinson disease. Clin 
Neuropharmacol. 2009 Jan-Feb;32(1):48-50
7 Roy s, Fortier LP. Fentanyl induced rigidity during emergence from GA potentiated by venlafaxine. Can J Anaesth. 2003 Jan;50(1):32-5.

Overdose  Resources

 
(and other Unusual Overdose Presentations)
Fentanyl-Induced Muscle Rigidity 



How to Insert an Oropharyngeal (Guedel) Airway
BY JOHN FURST · PUBLISHED DECEMBER 18, 2017 · UPDATED DECEMBER 5, 2017

Advanced first aiders and first responders may be trained in the use of Oropharyngeal (OP) airways. These devices are 
sometimes called Guedel airways.

An OP may be required to achieve or maintain an open airway. The OP conforms to the shape of the palate. When 
inserted into an unconscious patient, it can assist in maintaining a clear airway by preventing obstruction by the tongue. 
This enables the passage of gases through and around the tube and facilitates suctioning (if trained).

Inserting an oropharyngeal (OP) airway
Select an appropriately sized OP. An oversized OP airway could obstruct the airway by depressing the epiglottis. The 
tongue could obstruct an airway that is too small. The correct size can be confirmed by placing the tube at the side of the 
cheek and ensuring it is level with the front of the teeth and reaches the angle of the jaw.

The airway should be inserted ‘upside down’ and it is then rotated as it nears the posterior wall of the pharynx 
so that it points downward.

An OP airway may be useful in maintaining an open airway during bag-valve-mask ventilation.

An OP airway will not prevent aspiration of stomach contents. It only stops the tongue from obstructing the 
back of the pharynx. The patient may still need to be placed in the recovery position in order to protect the 
airway from stomach contents. 

Always re-assess after performing any airway intervention.
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1.	 Participant Knowledge Review

2.	 Overdose Response and Stress

3.	 Facilitation Tips

4.	 Take Home Naloxone Paperwork

Take Home Naloxone Forms:

Distribution Record

Overdose Response Information Form

New Site Registration Form

Supply Order Form

Participant Knowledge Checklist

Train the Trainer and Naloxone Distribution

Topics

Total Time

60 Minutes
Equipment 

& Materials:

Naloxone Kits

Photocopies of 
handouts

P

P
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PARTICIPANT KNOWLEDGE REVIEW: 

1. Overdose prevention – causes, contributing factors, prevention 
strategies, and types of overdose.

2. Signs of an opioid overdose 

3. Recovery position and application of breaths

4. SAVE ME Steps

a.Stimulate

b. Airway 

c. Ventilate

d. Evaluate

e. Muscular Injection

f. Evaluate

5. Evaluation and aftercare

6. Care of naloxone and refills

7. Administration information form

1 Section Time

 15 Minutes

Presenter(s)

_________

 
Helpful online 

refresher course 
available here: 

wwww.towardtheheart.
com/naloxone-course
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OVERDOSE RESPONSE AND STRESS:

When you’re training a trainer, ensure that they understand and address 
the emotions of the person responding to the overdose

Ask the group: What goes through your mind before, during and after 
when you respond to an overdose?

1. Before the Overdose

- Your first reaction is normal!

2. During the Overdose

- You are in a stressful situation! Remember to breathe! 

- It’s important to get the person to practice breathing.

3. After the Overdose

- Remember to go do something good for yourself after an overdose 
response.

2 Section Time

20 Minutes

Presenter(s)

_________
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FACILITATION TIPS:

Ask the group: What skills folks found successful in regards to 
facilitating naloxone trainings?

Fraser Health Tips for Engaging in Overdose Conversations

1. Start the conversation by asking for permission

2. Ask the person about their level of concern about the risk of 
overdose for themselves, their family or their friends

3. Listen without judgement

4. Invite the person to describe what steps they are currently taking to 
keep themselves, their family or their friends safe

5. Ask the person if they are open to additional resources

a. Explore the idea of training them on naloxone here!

3

• The importance of reflection and 
affirmation – you can do something to 
help!

• Ensuring that your audience is 
comfortable

• Ensure that you introduce yourself

• Ask questions and look for feedback 
from the audience

• Be relaxed and have a positive attitude, 
don’t take criticism too harshly

• Use storytelling and your lived 
experience to create an emotional 
connection

• Keep it simple and as short as possible

• Great creative – have hand outs, videos, 
hands on practice, etc.

• If it’s a long training, share ground rules 
– i.e. washroom locations, when there 
will be smoke breaks, etc.

Things to remember:

Section Time

10 Minutes

Presenter(s)

_________
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TAKE HOME NALOXONE PAPERWORK:

Review all the forms with the group:

Distribution Record

•	 When you hand out a kit fill this out

Overdose Response Information Form (2 pages)

•	 When you use a kit fill this out

New Site Registration Form (2 pages)

•	 When you want to become a site fill this out

Supply Order Form (2 pages)

•	 Use this form to order kits and training supplies

4 Section Time

15 Minutes

Presenter(s)

_________



TAKE HOME NALOXONE: DISTRIBUTION RECORD 
        Fax/email this form monthly to 604.707.2516 or naloxone@bccdc.ca 

Site ID# Full Site Name  City  

DATE KIT 
GIVEN OUT 

KIT RECIPIENT DESCRIPTION NOTES  **Optional Site Use** 
(not required by BCCDC)OD RISK GENDER AGE RANGE (YRS) 1ST KIT OR REPLACEMENT 

MM/DD/YYYY   At risk of OD 
  Not at Risk 

  Male 
  Female 
  Other 

  < 19       19-30 
 31-60   > 60 

 1st Kit 
 Replacement (Last Kit Used) 
 Replacement (Other Reason) 

MM/DD/YYYY   At risk of OD 
  Not at Risk 

  Male 
  Female 
  Other 

  < 19       19-30 
 31-60   > 60 

 1st Kit 
 Replacement (Last Kit Used) 
 Replacement (Other Reason) 

MM/DD/YYYY   At risk of OD 
  Not at Risk 

  Male 
  Female 
  Other 

  < 19       19-30 
 31-60   > 60 

 1st Kit 
 Replacement (Last Kit Used) 
 Replacement (Other Reason) 

MM/DD/YYYY   At risk of OD 
  Not at Risk 

  Male 
  Female 
  Other 

  < 19       19-30 
 31-60   > 60 

 1st Kit 
 Replacement (Last Kit Used) 
 Replacement (Other Reason) 

MM/DD/YYYY   At risk of OD 
  Not at Risk 

  Male 
  Female 
  Other 

  < 19       19-30 
 31-60   > 60 

 1st Kit 
 Replacement (Last Kit Used) 
 Replacement (Other Reason) 

MM/DD/YYYY   At risk of OD 
  Not at Risk 

  Male 
  Female 
  Other 

  < 19       19-30 
 31-60   > 60 

 1st Kit 
 Replacement (Last Kit Used) 
 Replacement (Other Reason) 

MM/DD/YYYY   At risk of OD 
  Not at Risk 

  Male 
  Female 
  Other 

  < 19       19-30 
 31-60   > 60 

 1st Kit 
 Replacement (Last Kit Used) 
 Replacement (Other Reason) 

MM/DD/YYYY   At risk of OD 
  Not at Risk 

  Male 
  Female 
  Other 

  < 19       19-30 
 31-60   > 60 

 1st Kit 
 Replacement (Last Kit Used) 
 Replacement (Other Reason) 

MM/DD/YYYY   At risk of OD 
  Not at Risk 

  Male 
  Female 
  Other 

  < 19       19-30 
 31-60   > 60 

 1st Kit 
 Replacement (Last Kit Used) 
 Replacement (Other Reason) 

MM/DD/YYYY   At risk of OD 
  Not at Risk 

  Male 
  Female 
  Other 

  < 19       19-30 
 31-60   > 60 

 1st Kit 
 Replacement (Last Kit Used) 
 Replacement (Other Reason) 

MM/DD/YYYY   At risk of OD 
  Not at Risk 

  Male 
  Female 
  Other 

  < 19       19-30 
 31-60   > 60 

 1st Kit 
 Replacement (Last Kit Used) 
 Replacement (Other Reason) 

MM/DD/YYYY   At risk of OD 
  Not at Risk 

  Male 
  Female 
  Other 

  < 19       19-30 
 31-60   > 60 

 1st Kit 
 Replacement (Last Kit Used) 
 Replacement (Other Reason) 

MM/DD/YYYY   At risk of OD 
  Not at Risk 

  Male 
  Female 
  Other 

  < 19       19-30 
 31-60   > 60 

 1st Kit 
 Replacement (Last Kit Used) 
 Replacement (Other Reason) 

MM/DD/YYYY   At risk of OD 
  Not at Risk 

  Male 
  Female 
  Other 

  < 19       19-30 
 31-60   > 60 

 1st Kit 
 Replacement (Last Kit Used) 
 Replacement (Other Reason) 

MM/DD/YYYY   At risk of OD 
  Not at Risk 

  Male 
  Female 
  Other 

  < 19       19-30 
 31-60   > 60 

 1st Kit 
 Replacement (Last Kit Used) 
 Replacement (Other Reason) 

July 2020 



 TAKE HOME NALOXONE:
OVERDOSE RESPONSE INFORMATION FORM 

Please complete this form after you use a naloxone kit  
And E-MAIL to naloxone@bccdc.ca 
If you don’t have e-mail please fax to 604.707.2516 Today’s Date:_____________________________ 
 
 

1. When did the overdose happen? (month and year) 

   Don’t know  Prefer not to say 

 MONTH YEAR     
 

2. In what city/town/community did the overdose happen? 

   Don’t know  Prefer not to say 
 

 

3. Describe the overdose event 

  Person who 
overdosed was 
found alone 

 Person overdosed in 
front of others 

 Don’t know  Prefer not to say 

 

4. Where did the person overdose?   

  Private Residence  Supportive Housing  SRO  Shelter 

  Tent  Street/Alley/Park  Hotel/Motel  Community 
Agency/Drop-In 

  Bar/Night-Club/ 
Concert/Festival 

 Other  Don’t know  Prefer not to say 

 

5. Describe the person who overdosed. 

Gender  Male  Female  Trans  Gender diverse 

 Don’t know  Prefer not to say     Other                        
  

Age  Under 19 years  19-30 years  31-60 years  Over 60 years 

 Prefer not to say    
 

6. Did anyone call 911? 

  Yes  No – had the situation 
under control 

 No – worried 
police would 
come 

 No – worried family 
services would be 
notified 

  No – other reason  Don’t know  Prefer not to say   

20-Dec-2018 



 

7. Which first responder(s) arrived FIRST (check ALL that apply if they arrived at the same time) 

  Fire  Ambulance  Police  Prefer not to say 
 

8. Did police come to the overdose? 

  Yes  No  Don’t know  Prefer not to say 
 

9. Did anyone do rescue breathing (mouth to mouth)? 

  Yes  No – person was 
breathing 

 No – other reason  Prefer not to say 

 

10. How many injections of naloxone were given? 

  1  2  3  4 

  5  6  7  8+ 

  Don’t know  Prefer not to say     
 

11. Did the person who received naloxone have any negative effects (check ALL that apply)? 

  No  Yes – withdrawal 
(mild) 

 Yes – withdrawal 
(moderate) 

 Yes – withdrawal 
(severe) 

  Yes – was 
aggressive 

 Yes - Other  Don’t know  Prefer not to say 

 

12. Did the person who overdosed:  

  Travel by 
ambulance to 
hospital 

 Travel by other 
transport to hospital 

 Decline transport 
to hospital 

 Prefer not to say 

 

 For more information about the program visit:  
www.towardtheheart.com/naloxone 

 

20-Dec-2018 
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 SITE IN

FO
RM

A
TIO

N
 (i.e. the place w

here the Site Contact is located/the Site Contact’s organization) 

Site N
am

e: 
 

 Address 
Street # 

 
 Street N

am
e: 

 
 Street Type: 

 
 D

irection: 
 

 U
nit: 

 
Floor: 

 

City: 
 

Postal Code 
  

 SITE CO
O

RD
IN

A
TO

R (W
ho w

ill be the m
ain site contact for the program

/contact for BCCD
C correspondence) 

 
 First N

am
e 

 Last N
am

e 
 Phone N

um
ber 

 Em
ail (required) 

Coordinator 1 
 

 
 

 

Coordinator 2 
 

 
 

 

  SITE D
ELIVERY AD

D
RESS (W

here orders should be delivered) 

Site N
am

e: 
 

 Address 
Street # 

 
 Street N

am
e: 

 
 Street Type: 

 
 D

irection: 
 

 U
nit: 

 
Floor: 

 

City: 
 

Postal Code 
  

*N
ote that kits can N

O
T be m

ailed to a PO
 Box or Bag 

D
ELIVERY IN

STRU
CTIO

N
S 

Phone N
um

ber 
 

Special D
elivery Instructions (ex. buzzer #) 

 

 H
ours of O

peration (For D
elivery) 

  N
ote: D

elivery H
ours are M

onday to 
Friday betw

een 9am
 and 5pm

. Please 
indicate availability betw

een these 
hours. 

M
onday: 

 
Closed for Lunch: 

 

Tuesday: 
 

Closed for Lunch: 
 

W
ednesday: 

 
Closed for Lunch: 

 

Thursday:  
 

Closed for Lunch: 
 

Friday: 
 

Closed for Lunch: 
 

 

**Please E-M
AIL this com

pleted form
 along w

ith the N
ew

 Site A
greem

ent to naloxone@
bccdc.ca** 

**If you do not have e-m
ail, please fax to (604) 707-2516** 
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TAKE HOME NALOXONE: 
NEW SITE AGREEMENT

 
 

Please complete the checklist below: (underlined text is hyperlinked) 
Required 
 Reading 

 ☐ I have reviewed the Training Manual: Overdose Prevention, Recognition and Response 
 
About THN Trainers: A Take Home Naloxone trainer can be anyone who has reviewed and understands the 
material in the training manual and who is able to demonstrate the preparation and giving of an intramuscular 
(IM) injection.  
 

 Coordinator Responsibilities 
□ I will be the key point of contact for BCCDC and will inform the program about: 

 changes in: coordinators (immediately); educators and distributors (annually) 
 changes in physical location or contact info 

□ I will ensure that site staff have received the appropriate training 
□ I will fax the following forms at least once a month to BCCDC at 604-707-2516 

 Naloxone Distribution Record 
 Overdose Response Information Form (help client complete after he/she uses kit) 

□ I understand that new orders for THN kits will NOT be filled  if the site is not compliant in submitting 
paperwork for kits distributed from a previous order. 

    
 Setting up your Site 

□ The New Site Registration form (this document) has been completed (all pages) 
□ I understand that I will need to submit an order form for training supplies and THN kits, and should 

do so approximately one month before my site is ready to begin training participants/clients 
Optional 

□ My site can be mapped for the public in the searchable site finder at www.towardtheheart.com 
► If YES, which address should be mapped? 

 

      Street:   Postal Code:    
 

Phone:    

   
 
 

I have read and understand the Take Home Naloxone Site Agreement, and have completed the checklist above: 
 

 Coordinator Name (Print) Signature Date  
    

   

**Please E-MAIL this completed form along with the New Site Registration Form to naloxone@bccdc.ca ** 
  **If you do not have e-mail, please fax to (604) 707-2516** 
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TAKE HOME NALOXONE : SUPPLY ORDER FORM
Registered Sites Only – Supplies not intended for use in the workplace  

E-mail form to naloxone@bccdc.ca if you don’t have e-mail, please fax to 604-707-2516

E- mail naloxone@bccdc.ca for queries, follow-ups or changes to orders.
Please allow 10 working days for delivery and plan ahead to avoid shortages. 

 
 
 

 
INVENTORY COUNT (NUMBER OF THN KITS ON SITE):                   Kits 
 
 
Site #    Site Name: Date Submitted:

Contact Name: Delivery Days & 
Times:

 

Shipping Address:
Phone/Email:

 
Products Contents Unit of Issue Quantity Ordered

 
Completely
Assembled

THN Kit

1 x Black case 
3 x Naloxone, 0.4 mg/mL, 1 mL ampoule 
3 x Vanish Point® 3 mL syringe 1 x  
1 x  Amber medication bottle with label 
3 x Plastic ampoule breakers  
1 x Pair of non-latex gloves  
3 x Alcohol swabs 
1 x Individual breathing mask in pouch 

 
 
 
 
 
 

1 kit

 
 
 
 

  Kits
 

 
 

Naloxone 
Replacement Bottles 

(to refill used kits)

3 x Naloxone, 0.4 mg/mL, 1 mL ampoule 
1 x Amber medication bottle with label  
3 x Plastic ampoule breakers 

   Naloxone expiry label on bottle  

 
 
 

1 bottle

 

 
  Bottles

 
(Kit Refills Only)

 
 
 
 

Mock Kit
(for training purposes)

1 x Black Case 
3 x Water ampoules, 1 mL 
3 x Vanish Point® 3 mL syringe  
1 x Amber medication bottle with label  
3 x Plastic ampoule breakers 
1 x Pair of non-latex gloves  
3 x Alcohol swabs 
1 x Individual breathing mask in pouch 
 
 

 
 
 
 
 

1 kit

 
 
 
 

  Kits
 

maximum: 5 

  Circle Quantity Required 
Loose Supplies 

(for replacement kits or 
training purposes) 

Vanish Point® 3 mL syringe 100        200        300 
Plastic ampoule breakers  100        200        300 

Water ampoules, 1 mL                              100         200        300 
Individual breathing mask in pouch 
(Available only for kit refills ONLY, quantity ordered should match 

quantity of ‘Naloxone Replacement Bottles’ ordered)  

 

OD Survival Guide Brochure – English  50    100    150    200    250    300 
Box non-latex gloves  

Good Samaritan Drug Overdose Act Wallet Cards – 
English  50    100    150    200    250    300 

This form is only for approved sites participating in the Take Home Naloxone program.  
Page 1 of 2 
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Naloxone Training Videos are available for viewing under the Participant Training resources found here: 
http://towardtheheart.com/naloxone/. These videos may also be downloaded directly from the following Vimeo links: 

• Naloxone Saves Lives - https://vimeo.com/164669763  
• Naloxone Wakes You Up - https://vimeo.com/hellocoolworld/review/180116125/5bbda65390  

 
 

Take Home Naloxone Supply Ordering at the BCCDC 
 

To receive Take Home Naloxone supplies, sites must be registered in the program.  To learn more, visit 
http://towardtheheart.com/naloxone/.  

 

General Notes about Supplies 
 

• Any changes to supplies will be posted on towardtheheart.com and made to the Supply Requisition Form 
• Use older supplies first. Remember: First In, First Out (FIFO) 
• Naloxone has shelf-life of ~2 years. Check the expiry of your kits before dispensing to clients 
• Naloxone within 3 months of expiration should not be dispensed to clients. Order new naloxone for replacement 

 
BCCDC Weekly Processing 

 
• To order supplies, fill out the attached Take Home Naloxone Supply Requisition Form and fax it to 604-707-2516. 
• For timely processing, we recommend submitting your order by Wednesday. All orders received after the cut-off 

time of 11:59pm on Wednesday will be processed the following week and delivery will be delayed. 
• The supplies will be packaged at the BCCDC pharmacy during the week following the placement of the order. The 

packages will then be shipped out to the site. Delivery time is expected to be 10 working days. 
• To avoid disruption of services, plan ahead and place an order before you run out of stock. 
• Please ensure the THN program coordinator is informed of changes to contact information to avoid the requisition 

form from not being processed. 
 
How Much to Order 

 
• We suggest that sites order on a monthly basis to avoid a surplus of stock that may go unused or expired. For high 

volume sites, we recommend ordering weekly as needed. 
• Naloxone has a shelf-life of ~2 years. To ensure that clients are given naloxone kits that have the longest possible 

shelf-life, we encourage sites to order enough supplies to distribute for 2-3 months. 
• Typical order sizes: 

o Smaller sites: 20 kits 
o Larger sites: 50 kits 
o New sites: 10 kits 

• BCCDC staff may need to follow up with the sites placing unusually large or small orders 
• We recommend ordering 1 syringe, 1 water ampoule and 1 OD survival guide brochure for every kit ordered so 

staff can train clients. Sites training a large number of staff or family/friends of clients should order additional 
training supplies as needed. Smaller sites may order smaller quantities of loose supplies. 

 
Receiving Supplies and Questions 

 
• Please check your order upon receipt. Ensure that you receive the correct quantity and that the supplies reach you 

in good condition. If you notice any discrepancy, or have any questions or concerns about the distribution of take 
home naloxone supplies, please email naloxone@bccdc.ca  

Page 2 of 2 
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Initials  
 Overdose

Prevention
• Demonstrates clear knowledge of causes, contributing factors, and
prevention strategies to overdoses
• Demonstrates understanding of stimulant overdose – there is no antidote
• Knows the application of myths in responding to overdose can be harmful

 Signs of Opioid 
Overdose

• Understands the signs of an opioid overdose:
breathing is very slow/ erratic or not there at all, fingernails/lips blue or 
purple, unresponsive to stimulation/sternal rub, deep snoring/gurgling sound,
body is limp, unconscious
• Understands that naloxone does not work for non-opioid overdoses

 Recovery
Position and 
Calling 911

• Can demonstrate the recovery position and knows to put the person in this
position if they have to leave them alone to keep airway clear
• Understands the importance of calling 911, knows what to say to the 911
operator and knows to debrief EMS when they arrive

 Stimulation & 
Application of 
Breaths

• Demonstrates understanding of how to provide stimulation: Sternal
Rub/Say the person’s name/Tell them to breathe
• Demonstrates understanding of how to provide breaths and use 1-way face 
mask

 Naloxone
Administration

• Demonstrates understanding, including: 1 mL into muscle of upper
shoulder, upper thigh, or upper-outer quadrant of buttocks. If no change in
condition within 3-5 minutes – should give another dose of naloxone

 Evaluation & 
Aftercare

• Demonstrates knowledge that the effect of naloxone only lasts 30-90 
minutes and the overdose can return
• Knows to stay with person to communicate to that person: what happened, 
not to let person take more drugs; sickness will go away, more opioids will
have no effect while naloxone is active, and more drugs will make OD more
likely to return when effect of naloxone wears off
• Knows to watch for OD symptoms returning

 Care of
Naloxone 
Vial, Program 
Evaluation, 
Refill

• Demonstrates knowledge how to store naloxone at room temp and away
from light
• Watch expiry date on ampoules
• Keep naloxone in a regular place and let others know where it is in case of
an emergency
• Knows how to get a re-fill if used, and that more information is available at 

www.towardtheheart.com
• Knows the importance of completing and returning the Administration
Information form

 

TAKE HOME NALOXONE:
PARTICIPANT KNOWLEDGE 

CHECKLIST
 
 
 
This checklist provides a guideline to assess the knowledge of the participant following the 
training session. As the Educator you should be confident that each knowledge objective was 
covered in the training and that the participant understands each of the objectives.

 

Participant’s Name:    Date:   YYYY  / MM  /DD   
 
Educator’s Name (Print):_   

 

Knowledge Objective
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2016/10/21 



COVID and OD Response

Lesson: pg 43-45 
40 MINUTES

HEALTH, 
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PREVENTION
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WHAT DO WE KNOW ABOUT COVID AND OD RESPONSE?

•	 Responding to an overdose during COVID-19 carries with it a risk of 
transmission. 

•	 You can both give and get COVID from giving breaths, compressions, or 
just moving someone from their front onto their back.

Healthcare protocols have changed across the board, and VCH protocols 
differ depending on which environment someone person is in. 

Section Time

10 Minutes

Presenter(s)

_________

1.	 What do we know about COVID and OD response?

2.	  How can we reduce the risk?

3.	 Deciding to give breaths

COVID and OD Response

Topics

Total Time

40 Minutes

1

Module based on workshop 
developed by Izzi Kearns RN  
https://www.youtube.com/
watch?v=hJ9C6x7c4d4

Equipment 
& Materials:

Flipchart

Markers

P

P
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HOW CAN WE REDUCE THE RISK?

Ask the group: what are some things you have done to stay safer when 
responding to ODs during the pandemic?

Add or emphasize:

•	 Anyone not responding to the overdose should leave the room or 
immediate area. 

•	 When using a take home naloxone kit or facility overdose response 
box use the face shield/breathing barrier to give rescue breaths. 

	o The face shield has a one-way valve and large impermeable 
area which protects the responder from respiratory secretions. 

	o After responding dispose of the face shield before taking off 
the gloves and wash/clean hands thoroughly. 

•	 If chest compressions are needed, gently place a towel or a piece of 
clothing over the person’s nose and mouth 

•	 If you are immunocompromised, live with someone who is 
immunocompromised (has HIV/HepC/is over the age of 60, is a child 
under 5, has COPD, asthma, heart conditions, or cancer) the safest 
thing to do for your own risk is to stay as far as you can from the 
person’s upper body, and find someone else who can respond with 
breaths and CPR. 

•	 Bag valve masks can increase the risk of COVID. If possible you can 
move the person outside before using these. This will reduce the risk. 

•	 Administering oxygen at under 10 litres is low risk for the person 
providing it, and potentially life saving for the person receiving it. If 
someone is still breathing, administering oxygen through a face mask 
is a safer option

•	 If you provide breaths or CPR, monitor yourself closeley for COVID 
symptoms. Symptoms now include shortness of breath, fever, soar 
throat, cough, lack of taste or smell, headache, fatigue, nausea, and 
diarrhea. 

•	 If you present with any symptoms in the following days after 
responding, go to  for testing.

Section Time

15 Minutes

Presenter(s)

_________

2
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  BREATHS OR NO BREATHS?

•	 The decision to give or not give breaths may be more complicated 
than we would like to admit. 

•	 Your safety is as important as the safety of anyone you’re helping. 

•	 It’s important to discuss with your team, or people who you respond 
to overdoses with in your community, what you feel comfortable with 
before an overdose happens, not while you’re trying to respond. 

•	 Once we have discussed what we’re comfortable doing, we then 
need to consider how this will affect the way we respond to different 
situations.

SCENERIOS - (write key points on chart paper during discussion)

1) You observe someone against the wall who has slouched over. You 
approach them and they are not responsive. You feel for the pulse on 
their wrist and it is hard to find but you think you can feel it. Their lips are 
becoming dusky/greyish and you can’t tell if they’re breathing. 

Your coworker arrives behind you and you realize that you both feel unsafe 
giving breaths. 

Ask the group:
	o How do you proceed? 
	o How many people does it take to safely respond? 

2) You identify as someone who feels safe to give breaths through the face 
mask with the one way valve. Your coworker is behind you and you are 
unsure of how safe they feel responding. 

Ask the group:
	o How do you figure out what to do next? 

3) Your coworker identifies as someone who feels safe giving breaths 
through the face mask with the one way valve. You only feel safe giving 
compressions. 

Ask the group:
	o How do you figure out what to do next?

Section Time

15 Minutes

Presenter(s)

_________
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Harm Reduction Basics &
Safer Self Injection I & II

Lesson: pg 47-53 | Handouts: pg 54-57 
Part 1 - 40 MINUTES | Part 2 - 65 MINUTES

HEALTH, 
HARM REDUCTION 
& OVERDOSE 
PREVENTION
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1.	 Harm Reduction Supplies and How to Use Them

2.	  Safer Shooting

Harm Reduction Basics and Safer Self Injection

Topics

Total Time

40 Minutes

HARM REDUCTION SUPPLIES AND HOW TO USE THEM: 

Types of Harm Reduction Supplies

•	 Alcohol swabs

•	 Water vials

•	 Syringes with needle attached (1cc and 1/2cc)

•	 Ascorbic acid

•	 Disposable cookers (with filter)

•	 Condoms

•	 Non-latex insertive condoms

•	 Lube

•	 Tourniquet

•	 Syringes without needles (3 and 5 cc)

•	 Needle  
	 (18g x 1 ½”, 22g x 1”, 22g x ½”, 25g x 5/8”, 25g x 1”,

26g x ½”, 27g x ½”)

•	 Sharps bin (1L, 500mL)

•	 Pipes (meth / crack)

•	 Plastic mouth tubing

•	 Screens

•	 Push stick

1
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Section Time

20 Minutes

Presenter(s)

_________

Equipment 
& Materials:

Harm  
Reduction 
Supplies
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SAFER SHOOTING:

Ask the group: how do folks in the room think one can find a vein?

Finding a Vein

1. Drink lots of fluid (preferably water) before, during and after injection. 
Drinking water before injecting will make your veins bigger and more 
visible.

2. Tie a tourniquet (sounds like “turn-a-key”) above the place where 
you’ll inject—the further away, the better. Try a rubber tie-off, panty hose 
or a soft belt. Untie it before you start to inject.

3. Clench and relax your fist.

4. Gently slap the skin.

5. Apply a warm cloth over the vein.

6. Take a hot bath—you’ll find veins you never knew you had. But never 
take a hit in the bath—you could nod off and drown.

2

Ask the group: how do folks in the room think one can take care of their veins?

Vein Care Tips

1. Using the smallest needle possible can reduce track marks, swelling and bruising, but it can sometimes 
be harder to flag, so you may end up poking yourself several times before you’re able to inject. This 
can damage the vein, especially over time. You can try to use a slightly largergauge needle if it means 
that you’re able to flag right off the bat. Don’t be afraid of change—find out what works best for you. 
Remember to rotate your injection sites to minimize damage to the veins.

2. See or feel the vein before you start to bang.

3. Clean the area with an alcohol swab.

4. Always inject with the bevel up (the bevel is the sliced angle at the end of the needle).

5. Flag—pull back on the plunger until you see blood in your

barrel (this way you know you’re in the vein).

6. Insert the needle in the same direction as the blood flow in your veins. Then inject slowly.

7. Never shoot into an artery! An artery has a pulse. You’ll know if you hit one because it will really hurt, 
the blood pressure will force the plunger backwards, the blood will look foamy, and it will take longer 
to stop the bleeding. If this happens, take the needle out right away. Press down hard on the site until 
bleeding stops. If it doesn’t stop in 5 minutes, you need to go to the hospital right away!

Section Time

20 Minutes

Presenter(s)

_________
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SAFER SHOOTING continued: 

More tips:

•	 Use a tourniquet to help find a vein

•	 Clean with an alcohol swab first: this prevents bacteria from getting in your blood and also makes the 
veins shiny so you can see them better!

•	 Don’t lick the injection, after because bacteria can get in and give you an abscess 

•	 Try to wait 10-15 minutes between doses so your opioid receptors have time to use what is already in 
your system.

•	 Do a half shot or “tester” dose to feel the strength in case its super strong

•	 Hydrate by drinking water and or electrolytes before your shot so your veins stand out more

•	 Try not to re-use the same vein and rotate vein sites regularly so that they can heal between injections

5

Dangerous! Never 
inject here!

Better NOT to inject 
here, but safer than 
red. Inject with 
caution, slowly.

These are the safest 
and best veins to use. 
Remember to rotate 
sites!

This diagram shows the 
risk levels of injecting into  
different areas of the body.
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1.	 How to Prepare a Successful Shot

2.	 Dose Management

3.	 Doctoring

4.	 Risks of Infections and Treatments and Infection Prevention

Safer Self Injection II

Topics

Total Time

65 Minutes

HOW TO PREPARE A SUCCESSFUL SHOT: 

Ask the group:  how can you prepare a successful shot?

Ask for volunteers to demonstrate the steps for each Heroin, Meth, Crack 
and Powder Cocaine using harm reduction supplies. Fill in any steps that 
are missed

Heroin

1. Wash Hands

2. Remove cooker from package, attach plastic handle cover

3. Put drug into cooker (If the heroin is in a hardened rock form it needs 
to be crushed)

4. Add preferred amount of sterile water 

5. Heat drug and solution in cooker

6. Heat to point where bubbles appear, stirring if need to, until powder 
dissolves

7. Remove rig from package

8. Place filter on rig or cotton filter into cooker

9. Draw solution from cooker through the filter

10. Carefully remove filter if attached to rig

11. Finished; see qualified staff for safer injection technique if required

1 Section Time

20 Minutes

Presenter(s)

_________

Equipment 
& Materials:

HR Supplies

Photocopies of 
handouts

P

P
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Powder Cocaine

1. Wash Hands

2. Remove cooker from package and attach 
plastic handle cover

3. If it needs to be crushed do this in a folded 
paper sleeve

4. Put drug into cooker and add preferred 
amount of sterile water

5. Using syringe plunger stir mixture until 
powder dissolves

6. Remove rig from package

7. Place filter on rig or cotton filter into cooker

8. Draw solution from cooker through the filter

9. Carefully remove filter if attached to rig 

10. Finished; see qualified staff for safer injection 
technique if required

Meth

1. Wash hands

2. Remove cooker from package and attach 
plastic handle cover

3. Put drug into cooker

4. Add preferred amount of sterile water

5. Stir mixture until crystals dissolve

6. Remove rig from package

7. Place filter on rig or cotton filter into cooker

8. Draw solution from cooker through the filter

9. Carefully remove filter if attached to rig

10. Finished; see qualified staff for safer 
injection technique if required

Crack Cocaine

1. Wash hands

2. Remove cooker from package and 
attach plastic handle cover

3. Crush rock cocaine and place into 
cooker and add preferred amount of 
sterile water

4. Add ascorbic (or citric) acid (about 
1/3 to 1/2 of volume of crack)

5. Stir the crack, ascorbic acid, and 
water mixture with the sterile end of 
a capped syringe until dissolved

6. Add more ascorbic acid if the 
crack does not dissolve (there is 
often particulate residue left over 
that will not dissolve)

7. Remove rig from package

8. Place filter on rig or cotton filter 
into cooker

9. Draw solution from cooker 
through the filter

10. Carefully remove filter if 
attached to rig

11. Finished; see qualified staff for 
safer injection technique if required
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DOSE MANAGEMENT:

Ask the group: how could one manage their dose to prevent an OD?

•	 If a person is trying a new drug, using again after a long break or 
recently switched dealers, taking half a hit or half a dose to test the 
potency of the drug can help prevent overdose.

•	 If you are sick (i.e. common cold), have an immune deficiency, your 
tolerance can drop

2

DOCTORING:

Ask the group: what is doctoring? What do folks think safer doctoring 
looks like?

Safe doctoring
•	 If you’re having someone doctor your shot, make sure that they know 

what they’re doing
•	 If you are doctoring someone, ensure that you know what you are 

doing, it is also important to know the person you are doctoring and 
where their veins are laid out

•	 Don’t doctor someone else if you are high (i.e. on the nod)
•	 Cut out any chance of distractions if you are doctoring someone else

Consent
•	 Make sure you have the person’s full informed consent before you 

doctor them
•	 Consent can be withdrawn at any time, and this can be indicated with 

either words or actions. 
•	 No always means no, even if you or a partner initially agreed 

beforehand.
•	 Sometimes a person may say yes and later be hesitant or feel 

uncomfortable about continuing.
•	 If a person agrees to use drugs, but becomes unconscious or 

intoxicated by alcohol or drugs – the earlier consent does not count 
as a yes later. Activity must stop – and your priority should now be 
keeping your partner safe.

•	 If you are doctoring someone, always ask about where they would 
like you to inject, or if you want to try a new site.

3

Section Time

10 Minutes

Presenter(s)

_________

Section Time

15 Minutes

Presenter(s)

_________
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RISKS OF INFECTIONS AND TREATMENTS AND INFECTION PREVENTION:

Discussion: what are some common infections folks in the room see due 
to IV drug use?

Review Avoiding Infection handout (pg 44-47)

4 Section Time

20 Minutes

Presenter(s)

_________
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Cotton Fever (Septicemia)
CAUSE: Cotton fever is caused by bacteria from particles of dirt 
that grow on the filter fibres getting in your water, or from the stuff 
that the hit is cut with.

SIGNS: Feeling extremely cold no matter how well you cover 
yourself, nausea (sick to your stomach), vomiting, diarrhea, shakes 
and shivers, blinding headache, hot and cold sweating, twitches 
(feels like withdrawal).

CARE: Keep warm by covering yourself with blankets. Taking a 
hot bath helps, but make sure someone stays with you so you 
don’t drown. Get comfortable, and take medication for pain and 
vomiting if you need to. Don’t do another hit as this can make you 
feel worse. Go to the hospital if you want to, and ask someone to 
take you.

REDUCE YOUR RISK: Try to fix in the cleanest space possible. 
Try not to put your syringe down, as it may come in contact with 
dust or dirt. Use sterile water to mix your hit, and avoid sharing 
your wash with others. Use new dental filters each time—the kind 
given out at needle syringe programs—and change them often, as 
they tend to get loose and microscopic strips stick to the end of 
your needle, causing cotton fever. Always check in with staff at a 
needle syringe program and other users about any changes in the 
cut—they may have some info. 

26

Swollen Skin (Cellulitis)  
and Swollen Connective Tissue
CAUSE: Missing the vein, “digging around” with the needle, or 
spilling some of the hit between soft tissue (skin and muscle).

SIGNS: Redness, swelling, bumps that form right after injection 
(might look like hives or blisters) that may lead to scarring.

CARE: Apply ice or something cold. It can be helpful to keep a 
clean wet cloth or sock in your freezer. As soon as your skin starts 
to swell/bubble, throw the sock in cold water (to make it soft 
again) and wear it over the affected area. If swelling doesn’t go 
down in one hour, see a doctor.

REDUCE YOUR RISK: Make sure you are in the vein—try to flag 
by pulling back on the plunger until you see blood in your barrel. 
If you’re injecting crack/cocaine, remember that it can numb the 
area where you are injecting, so you may end up digging around 
more for a vein because you can’t feel pain in that area, and there 
could be a greater chance that you miss your hit. Pull out if it 
starts to hurt or swell. If you miss, try again in a different place 
to reduce the risk of infection and damage to skin and veins. If 
you’re missing regularly, you may be using the wrong needle. 
Remember that it makes more sense to use larger-bore needles 
and inject once than to use small-bore needles and have to poke 
yourself a dozen times until you get a vein. 
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Cotton Fever (Septicemia)
CAUSE: Cotton fever is caused by bacteria from particles of dirt 
that grow on the filter fibres getting in your water, or from the stuff 
that the hit is cut with.

SIGNS: Feeling extremely cold no matter how well you cover 
yourself, nausea (sick to your stomach), vomiting, diarrhea, shakes 
and shivers, blinding headache, hot and cold sweating, twitches 
(feels like withdrawal).

CARE: Keep warm by covering yourself with blankets. Taking a 
hot bath helps, but make sure someone stays with you so you 
don’t drown. Get comfortable, and take medication for pain and 
vomiting if you need to. Don’t do another hit as this can make you 
feel worse. Go to the hospital if you want to, and ask someone to 
take you.

REDUCE YOUR RISK: Try to fix in the cleanest space possible. 
Try not to put your syringe down, as it may come in contact with 
dust or dirt. Use sterile water to mix your hit, and avoid sharing 
your wash with others. Use new dental filters each time—the kind 
given out at needle syringe programs—and change them often, as 
they tend to get loose and microscopic strips stick to the end of 
your needle, causing cotton fever. Always check in with staff at a 
needle syringe program and other users about any changes in the 
cut—they may have some info. 
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Swollen Skin (Cellulitis)  
and Swollen Connective Tissue
CAUSE: Missing the vein, “digging around” with the needle, or 
spilling some of the hit between soft tissue (skin and muscle).

SIGNS: Redness, swelling, bumps that form right after injection 
(might look like hives or blisters) that may lead to scarring.

CARE: Apply ice or something cold. It can be helpful to keep a 
clean wet cloth or sock in your freezer. As soon as your skin starts 
to swell/bubble, throw the sock in cold water (to make it soft 
again) and wear it over the affected area. If swelling doesn’t go 
down in one hour, see a doctor.

REDUCE YOUR RISK: Make sure you are in the vein—try to flag 
by pulling back on the plunger until you see blood in your barrel. 
If you’re injecting crack/cocaine, remember that it can numb the 
area where you are injecting, so you may end up digging around 
more for a vein because you can’t feel pain in that area, and there 
could be a greater chance that you miss your hit. Pull out if it 
starts to hurt or swell. If you miss, try again in a different place 
to reduce the risk of infection and damage to skin and veins. If 
you’re missing regularly, you may be using the wrong needle. 
Remember that it makes more sense to use larger-bore needles 
and inject once than to use small-bore needles and have to poke 
yourself a dozen times until you get a vein. 
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Heart Infection (Endocarditis) 
CAUSE: Dirt or bacteria that get into your veins when you inject 
eventually travel to your heart valves where they build up. As your 
heart beats, little pieces of this build-up can shake loose into the 
bloodstream, causing embolisms (see page 28 on Embolisms).

SIGNS: Chest pains, shortness of breath, 
fever, heart palpitations and/or fainting.

CARE: See a doctor when symptoms 
first appear; if left untreated, you  
could die.

REDUCE YOUR RISK: Try to make 
sure all your works and your injection 
site are clean. Use a new needle and 
filter every time. With re-used filters, 
microscopic cotton fibres can stick 
to the end of the needle, and then 
travel through your bloodstream 
and cause heart infection.
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Skin Infections (Abscesses)  
CAUSE: Dirt or germs on the skin at the injection site (from not 
cleaning the site properly), missed hits, using the same site over 
and over, picking your scabs or not giving your scabs a chance  
to heal.

SIGNS: Redness and swelling at the injection site, which turns 
into a pus-filled sore.

CARE: Clean the abscess with soap and water, then keep it dry 
and apply a bandage. Abscesses do not go away on their own. See 
a doctor, go to the hospital or talk to someone at your local needle 
syringe program. If left alone, it could turn into a serious blood 
infection, and, in some cases, people can lose an arm or leg. 

REDUCE YOUR RISK: Be sure to wash your hands, clean your 
spoon before you cook your hit, and clean your injection site with 
an alcohol swab before you inject. Flag to make sure you’re in a 
vein before you inject. Some drugs, like crack/cocaine, are more 
likely to cause abscesses because it can be easy to miss your hit 
if the injection site has become numb from a previous injection.
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Blood Clots and Embolisms
Blood clots can form in veins throughout the body. An embolism is 
a free-floating blood clot that moves through the veins and arteries.

CAUSE: Injecting pieces of dirt or bacteria can cause clots, which  
get stuck in the vein and block the flow of blood to the heart. 
Blood clots can also form around scarred veins. Embolisms can 
form from infections which cause build-up on the valves of your 
heart (see page 33 on Heart Infections) and then break off into 
your bloodstream.

SIGNS: Pain and swelling in the arm or leg, if this is where the 
blood clot is. If the clot is in your lungs, it may cause chest 
pain, shortness of breath, unconsciousness or death. A blood 
clot in your brain is called a stroke and can cause numbness or 
weakness in any part of your body, fainting, blurred vision, speech 
problems, unconsciousness or death.

CARE: Go to a hospital right away. This is serious. You could die!

REDUCE YOUR RISK: Try to keep dirt and bacteria out of your 
hit. Use a new needle, sterile water, clean cooker, tourniquet/tie 
and filter every time you inject. You can prevent vein damage by 
following the Vein Care tips on pages 6 to 9. Also do not keep 
bloody hits in your syringe for long. For example, if you’ve partially 
flagged but moved to another injection site, try to find the new site 
fairly quickly because the blood in the barrel will start to coagulate 
and form into clots. Never keep a bloody hit for later use.
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HIV 
HIV (which stands for human immunodeficiency virus) is a virus 
that weakens your immune system, your body’s built-in defence 
against disease. There is no vaccine or cure for HIV, but with early 
diagnosis, treatment and care, most people with HIV can stay 
healthy and live a long, full life. The only way to tell if you have it 
is to get tested through a simple blood test.

HIV is passed through blood, semen (cum and pre-cum), vaginal 
secretions (pussy juice), anal fluids (ass juice) and breast milk. 
To get HIV, the virus in one of these fluids must come into direct 
contact with your bloodstream or the moist lining in the vagina, 
ass, foreskin or pisshole of the cock. This usually happens through 
sharing injection equipment and through unprotected vaginal and 
anal intercourse, and, very rarely, cock sucking. HIV cannot be 
passed through other body fluids (like sweat, tears, spit or piss) 
because they don’t hold enough of the virus to infect a person.

When you inject a hit, you make a direct, open path to your 
bloodstream. This means there is a very high risk of HIV infection. 
Whether you are HIV positive or HIV negative, you can help to stop 
HIV from passing between people.

To lower the chance of HIV infection:

• Avoid sharing, lending or borrowing works!

• Use new equipment every time. Go to your local needle 
syringe program to get new works.
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• Don’t handle or hold other people’s works and don’t let 
them handle or hold yours.

• If you don’t have access to enough new needles, mark 
yours clearly so there is no confusion. You can mark 
your needle by burning or breaking off a tiny piece of 
the plunger or mark it with a pen.

• Use a latex condom every time you fuck (that goes for 
anal sex too).

• Get tested for HIV and other STIs (sexually transmitted 
infections). If you know your status, you can take steps 
to be healthier and safer.

Contact any community health centre or needle syringe 
program near you to get free condoms and water-based 
lube (ask about how to use them properly!), and to find  
out where you can get tested for HIV.

HIV treatment is another important tool for stopping HIV. 
We know that people with HIV who are adherent to their 
treatment and maintain an undetectable viral load are 
much less likely to pass on HIV when sharing drug 
use equipment. And when it comes to sex, people on 
successful HIV treatment with an undetectable viral 
load do not pass on HIV during sex. For HIV-negative 
people, taking HIV drugs in the form of PrEP (pre-
exposure prophylaxis) can help lower your chance 
of becoming HIV positive. You can talk to a doctor 
or nurse to find out more
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Hepatitis B and C
Hepatitis B (Hep B), hepatitis C (Hep C) and HIV are passed on in 
similar ways. Using a condom when you have sex can protect you 
from HIV, Hep B and Hep C. 

CAUSE: Hep B and Hep C are viruses that infect the liver. The 
liver works like a filter in our bodies to clean the blood. Some 
people with Hep B or Hep C never get sick, but others get really 
sick. Regardless of whether you get sick or not, you can still pass 
the virus on to others. Hep B and Hep C can lead to liver disease 
or liver cancer, both of which can, in some cases, kill you.

SIGNS: Most people go a long time before having any signs of 
illness. When people do develop symptoms, they may include: 
being tired, having no appetite, stomach pain on the right side 
(where your liver is), weakness, nausea, fever, yellow skin and 
eyes, dark pee and pale shit. 

CARE: If you think you might have Hep B or Hep C, go to a doctor 
or clinic and ask to get tested. Once you know whether you’re 
infected or not, you can take steps to stay as healthy as possible. 
Treatment for Hep C cures most people of the virus. There is 
treatment for Hep B too. It helps to manage the virus, but doesn’t 
get rid of it. 
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REDUCE YOUR 
RISK: You can 
get a Hep B 
vaccination 
(a series of 
shots that 
protect you 
from getting 
the virus) from 
your local doctor or 
health clinic. After you get 
the vaccination, you will be 
immune to Hep B (you can’t 
get it!). This vaccine is free for 
people who can’t afford to pay. 
Unfortunately, there is no Hep C 
vaccination. 

Remember, you can protect 
yourself from getting either 
of these viruses by following 
the same safety tips as the 
booklet recommends for HIV. 
Shoot clean and fuck safe, and 
you’ll avoid HIV, Hep B and Hep C.
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1.	 Types of Drugs

2.	 Tolerance

3.	 Effects of Mixing Drugs

4.	 Knowledge Sharing around Safe Use

Let’s Talk About Drugs

Topics

Total Time

50 Minutes

TYPES OF DRUGS: 

Ask the group: What are different types of drugs, how do people use 
them and what are their effects?

“Classes” of Drugs

•	 Delineating different categories of drugs can be difficult because the 
lines are frequently blurry

•	 Some classifications of drugs include:

o Depressants (i.e. alcohol, opioid, benzodiazepines, barbiturates)

o Cannabinoids (i.e. weed, hash)

o Stimulants (i.e. Adderall, cocaine, meth)

o Hallucinogens (i.e. LSD, mushrooms)

o Inhalants (i.e. paint, dust off)

o Disassociatives (i.e. PCP, Ketamine)

Routes of Administration

•	 Parachute, smoking, snorting, hot rail, injecting, hooping, transdermal
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Common street drugs

Methamphetamine 

•	 Side, jib, ice, crystal, gack, glass, shard)

•	 Effects

o Increased heart rate, psychosis, hallucinations, mood swings, anxiety, increased energy, 
invincible feeling,euphoria, increased libido, increased blood pressure,no sleep

Opioids

•	 Fent, heroin, morphine, perks, down, dillies, oxies, H

•	 Effects

o Warm blanket feeling; euphoria; physical dependence; nodding out; malnutrition; sores; 
abscesses; OD; memory loss; dependency

Benzos

•	 Bluies, roofies, downers, sleepers, benzos, bennies

•	 Effects

o Relaxed muscles; decreased anxiety; euphoria; sleepiness; spaced out; memory loss; 
disassociation; withdrawal multiplies with alcohol; hard to reverse OD; heart attack and seizure 
from withdrawal

Cocaine

•	 Blow, snow, white, Charlie, soft, hard, powder, rock, hand, coke, up, more, toot, yay-o

•	 Effects

o Extreme sensitivity to touch, sound, and sight; intense happiness; anger/irritability; paranoid 
feeling; decreased appetite

o Headaches; convulsions and seizures; heart disease, heart attack, and stroke; mood problems; 
sexual trouble; lung damage; HIV or hepatitis if you inject it; bowel decay if you swallow it; loss of 
smell, nosebleeds, runny nose, and trouble swallowing, if you snort it
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Ask the group: What does sleep deprivation look like, and how does it affect people?  
(Optional: write key points on flip chart)

Effects of Sleep Deprivation

•	  Sleepiness can cause accidents

•	  Sleep deprivation can cause psychosis

•	  Sleep deprivation can lead to serious health problems 

o Heart disease, heart attack, heart failure, irregular heartbeat, high blood pressure, stroke, 
diabetes

•	 Sleep deprivation causes depression

•	 Sleep deprivation can cause memory loss

•	 Sleep deprivation causes impaired judgement, especially about sleep

•	 Sleep deprivation can cause death

Ask the group: What is stigma? What are some types of stigma drug users may encounter? 
(Optional: write key points on flip chart)

Stigma 

•	 Police brutality

•	 Ignorance from care providers

•	 Profiling

•	 Being denied work or housing

•	 Myths

o Moral deficiency – lazy / thief
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TOLERANCE:

Ask the group: What is tolerance?  
(Optional: write key points on flip chart)

Tolerance is your body’s ability to process a certain amount of a drug.

•	 Low tolerance means that your body can only process a small amount 
of a drug 

	o i.e., it takes less drugs to feel the effects

•	 Increased tolerance means your body has learned how to process 
increased amounts of the drug 

	o i.e., it takes more drugs to feel the effects

•	 Tolerance develops over time, so the amount of a drug a long-time 
user needs to feel the drug’s effects is a lot greater than a newer user.

•	 Tolerance also wavers depending on several factors including, weight, 
size, illness, stress, compromised immune system, and age.

•	 Tolerance can decrease rapidly when someone has taken a break 
from using a drug whether intentionally – for example, while in drug 
treatment or on methadone detox – or unintentionally – for example, 
while in jail or the hospital.

•	 Research has also shown that tolerance is effected when a person 
uses drugs in a new or unfamiliar environment, and therefore at a 
higher risk for overdose.

2 Section Time
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EFFECTS OF MIXING DRUGS:

Ask the group: What happens when someone mixes drugs?

•	 The risks of polydrug use depend on the types and amounts of drugs 
mixed.

•	 Combining drugs amplifies pleasurable and negative effects (for 
example, mixing stimulants, such as ecstasy and cocaine, can increase 
the user’s high, but also their risk of heart attack).

•	 The greatest risk of polydrug use is “combined drug intoxication.”

•	 Some of the side effects of combining drugs include:

o Brain damage, coma, heart problems, seizures, stomach 
bleeding, liver damage and failure, heatstroke, suppressed 
breathing, respiratory failure

•	 Mixing drugs severely depletes the brain’s feel-good and calming 
chemicals. This can spark behavioral issues such as depression and 
anxiety.

Common drug mixtures

•	 Alcohol and other drugs (i.e. cocaine, heroin, prescription stimulants, 
benzodiazepines, opioids) 

•	 Heroin and cocaine (speedball)

•	 Cocaine and ecstasy

3

KNOWLEDGE SHARING AROUND SAFE USE:

Ask the group: How can people stay safe when they are using drugs? 
(Optional: write key points on flip chart)

Harm Reduction in Relation to Use
•	 Test street drugs
•	 Don’t use alone, use sterile supplies, having naloxone and the training
•	 Replacement therapy
•	 Condoms and lube on hand because of potential forintercourse
•	 Narcan on hand 
•	 Use with others 
•	 Sleep, H2O, and snacks
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1.	 Common Community Resources

2.	 Spreading Information

3.	 Creating a Follow-up Project

Community Resources

Topics

Total Time

45 Minutes

COMMON COMMUNITY RESOURCES:

Ask the group: What resources may folks we engage with need to know 
about?

Common community resources
•	 Health care services
•	 Housing services
•	 Shelter services (low and high barrier)
•	 Food services
•	 Drug user services

o Opiate agonist therapy
o Harm reduction supplies
o Where to get naloxone kits
o Safe injection sites

1

SPREADING INFORMATION:

Ask the group: how can information be best spread in our community?

Common resource guide formats
•	 Booklet
•	 Map
•	 List
•	 Phone-line

2
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CREATING A FOLLOW UP PROJECT:

ACTIVITY

Have poeple split into small groups and come up with a project for 
distributing information about community resources. Give each group a 
large piece of paper and markers.

Questions for the groups to consider (have this written on the flip chart 
so groups can refer to it):

•	 Who are we trying to reach? (i.e. tenants in one building? entire 
neighbourhood?)

•	 What resources do we want to tell them about?

•	 What format will work best?

•	 How can we distribute our resource list to our community? 

•	 Who will update theinformation? 

•	 Who will coordinate the project?

Some points of process

•	 What is the purpose of the asset assessment and how will the results 
be used?

•	 What is the size/scope of the community being assessed?

•	 What people are available to do the work?

•	 How much time do you have for the task or how much time can you 
allow?

•	 How much money and other resources are available for incidental 
expenses?

3

REFERENCE: http://www.fris.org/Resources/ToolKit-Disabilities/PDFs/Section-A/A4.%20Creating%20a%20
Community%20Resource%20List.pdf
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1.	 Key COVID Information

2.	 Prevention without PPE

3.	 PPE

4.	 Using PPE safely

5.	 Practive Scenerios

6.	 Obstacles and Barriers 

COVID 19 and PPE

Topics

Total Time

60 Minutes

KEY COVID INFORMATION:

•	 Understanding transmission helps us assess risk. 

•	 Transmission happens via larger liquid droplets when someone 
coughs or sneezes. Droplets travel up to 2 meters

•	 Droplets enter through eyes nose or throat if you are closer than 2 
meters.

•	 COVID can also be transmitted to a surface and then someone can 
pick up the virus if they touch 
the surface and touch their 
eyes, nose or mouth

•	 COVID can be aerosolized 
with some medical 
procedures like using a bag 
valve mask. A bag valve mask 
will make covid droplets hang 
in air longer than normal.

Review Symptoms: see handout
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PREVENTION WITHOUT PPE:

1.	 Hand Hygeine. Review steps (handout)

2.	 Stay home if you are sick. If you start feeling sick when you are out, 
go home, or to a place that you are as isolated as possible.

3.	 Cleaning and disinfecting

•	 Step 1: clean surfaces with a sanitizing wipe to clean off dirt

•	 Step 2: clean surfaces with a new wipe to disinfect

2 Section Time

5 Minutes

Presenter(s)

_________

PERSONAL PROTECTIVE EQUIPMENT:

Review VCH guidelines:

•	 Step 1: assess your risk

•	 Step 2: decide what level of PPE you need

Ask the group: what kind of situations have you found yourself in that 
require PPE? What did you use?
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USING PPE SAFELY:

This information was made for VCH medical workers and includes 
maxiumim PPE. Whenever it’s possible the same techniques should be 
used by anyone working in the community.

1.	 Putting on PPE is called “Donning” - This is fairly straightforwar
	o Review handout (or if you have a computer and projector you 

can show the 1 1/2 minute video: https://www.youtube.
com/=eJsKmcblkiA&feature=youtu.be)

2.	 Taking off PPE is called “Doffing” - This is where you need to be 
careful of contaminating yourself!

	o Review handout (or if you have a computer and projector you 
can show the 2 1/2 minute video: https://www.youtube.com/
watch?v=ooZqZdehBCg&feature=youtu.be)

3.	 Steps to take when you get home after using PPE: Review handout:

4 Section Time
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PRACTICE SCENERIOS:

1.	 Someone in your building has chest pain, cough and fatigue and they 
collapse in the hallway.

Ask the group: what steps do you need to take?
•	 Provide first aid and call 911. They are exibiting symptoms of COVID.

In order to help them safely what PPE do you need? 
•	 Mask, eye protection, gloves and gown. 

What if I don’t have that stuff?
•	 Wear any gloves you have.
•	 Wear a homemade mask or bandana (as long as it’s not wet!).
•	 Protect your eyes from droplets by using glasses, goggles or 

sunglasses.
•	 Clean your hands after with soap and water or alcohol-based hand 

sanitizer.

2.	 You are out in the community and you develop symptoms. 

Ask the group: what should you do?
•	 Put on a mask
•	 Get tested
•	 Go home and wait for result

5 Section Time

15 Minutes

Presenter(s)

_________

BARRIERS AND OBSTACLES

Ask the group: how do we self-isolate for COVID-19 when living in 
shared housing?

Review VCH handout

Ask the group: what about people who are staying outside, in a shelter, 
a vehicle or with friends?

COVID 19 Outreach Team 
•	 Review COT handout: Services and Referral requirements

6 Section Time

10 Minutes

Presenter(s)

_________





Lather hands for a total of 30 seconds

how to handwash

Wet hands with
warm water.

1

Rub back of each
hand with palm of

other hand.

Pat hands dry
with paper towel.

5

9

Apply soap.

2

Rub fingertips
of each hand in
opposite palm.

Turn off water
using paper towel.

6

10

Lather soap and rub
hands palm to palm.

3

Rub each thumb
clasped in

opposite hand.

Your hands
are now safe.

7

 

11

Rub in between
and around fingers.

4

Rinse thoroughly
under running

water.

8
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Before 
Work

During 
Work

After
Work

Remove dedicated work shoes

Community Settings

For more information go to http://ipac.vch.ca/ Version 3: 19 May 2020

Ensure you have dedicated work shoes

Remove watches and all jewelry
Wear clean clothing to work that can be 
easily laundered

Wear dedicated work shoes
Bring food in a disposable bag or in a bag that 
can be cleaned and disinfected or laundered
No nail polish. No artificial nails. Perform 
proper hand hygiene

Put on clean clothes and ensure work 
clothes are washed prior wearing again

Perform hand hygiene before leaving work

Shower at home

Wash dishes, Tupperware, and water bottles 
used at work



How to self-isolate for
COVID-19 when living in
shared housing

If your test is negative and your symptoms
are mild: isolate until your symptoms are
gone .

If your illness gets worse: go back to your
clinic or testing site. You might need a second
test. 

If you have symptoms but haven’t had a
test:  isolate until 10 days after your symptoms
started AND your symptoms are gone. (A dry
cough that last more than 10 days is ok).

If you traveled outside Canada or are a
contact to COVID-19: isolate for 14 days from
your last day of contact/ travel.

Avoid using alone - ask someone to check on you
when you are using - even through the door. 
If you have a phone, download the Lifeguard App.
You can start the app's timer when you use. If you
are unconscious and can't silence the timer when it
goes off, it will send an ambulance to you.
Wash your hands before you use
Ask your clinic about  safer supply, or contact the
Overdose Outreach Team at  604.360.2874

Try to stay away
from other people 

Stay in your room as much as
you can

Self-isolate if you have symptoms of COVID-19, you've had contact to COVID-19, or after travel outside of  Canada.
Symptoms include: fever, cough, difficulty breathing, nausea, diarrhea. If you have symptoms, get tested at your clinic or at 429 Alexander St.

Schedule daily phone check-
ins with family or a buddy

When is isolation
over?

Wear a mask when out of your room

Wash hands often with soap and water or
hand sanitizer, especially when coming in
or going out of your room

Arrange for food to be delivered at your
door if you can

Wipe shared surfaces (i.e. doorknobs,
faucets) with disinfectant after touching

If you use substances

Monitor your symptoms - if they get worse,
seek medical help

If your do have
someone in your
room, stay 6 feet
apart or wear a mask

July 13, 2020

COVID-19 test results: 2 days after test, call 1-833-707-2792 
for this poster or more info: https://sneezesdiseases.com/covid-19-community-resources

email: VCHCovidClinicalSupportTeam@vch.ca



 

 

COVID Outreach Team (COT) 
Referral line: 604-290-3208 

P U R P O S E  

Purpose: The VCH COVID Outreach Team (COT) was established at the beginning of the COVID-19 pandemic to provide 
support to under-housed, precariously housed or other vulnerable clients who live in Vancouver and who have been 
diagnosed COVID-19 positive, symptomatic, or are at risk for contracting COVID-19. The team helps vulnerable clients 
access appropriate sheltering and isolation space. The team also helps to ensure primary health care and other care 
needs – including those related to mental health and substance use – are well supported. Once a client is cleared from 
Public Health (i.e., no longer infectious, or a COVID negative test result), the team coordinates smooth transition for 
clients back into community. 

C O T  S E R V I C E  D E S C R I P T I O N  &  D E T A I L S  
 
COT services include: 

• Outreach model nursing care for people who are COVID-19 positive, contacts of cases, symptomatic of 
COVID, or under quarantine 

• Supporting client urgent and primary care needs (nurse practitioners and/or GPs available on call) 
• Supporting client access to opioid agonist therapy (OAT) and/or medications to prevent withdrawal 
• Supporting client complex care coordination and transition planning 
• Supporting client access to infection prevention & control (IPAC) consultation and education 
• Community consultation regarding clients who are symptomatic, awaiting test results, or who are contacts 

to COVID + cases. 
 
When to reach out? If you are a service, including shelters, housing sites or other non-profits, who has had direct 
exposure to COVID or who has a positive COVID test result AND who doesn’t have the means to safely shelter-in-place 
please call our referral line. 
 
Referral line/process: To make a referral please call the COVID Outreach Team at 604-290-3208 (open 9am-6pm, 7 days 
a week) with as many of the following details as possible: 

• Your Name and Agency 
• Client’s name 
• Client’s date of birth 
• Client’s Personal Health Care Number (PHN) or PARIS # 
• Client’s COVID status: active symptoms of concern, if they have been tested (& date), if they require a test 
• Housing situation (i.e., shelter, SRO, recovery facility, many people in one location, etc.) 
• Best way to contact client for follow-up (phone, address, hang-out) 

 
If you have a general question or a question about a situation, feel free to email VCHCovidClinicalSupportTeam@vch.ca 
but do NOT include client name or ANY information that would constitute a client identifier. Note: COT Team Fax: 604-
707-2794 
 
Location: The team operates out of 1170 Bute Street, Vancouver. Clients are NOT seen onsite. COT outreach services are 
available across Vancouver. 
 
Staffing: The team includes outreach nurses (RN and LPNs), outreach workers and access to Clinical Practice Lead,  
Social Worker, GPs and Nurse Practitioners.  
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Managing Extreme Situations I:
Learning & Tips for Peer Outreach

Lesson: pg 78-79 
45 MINUTES
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1.	 Types of Abnormal Behaviours: 

2.	  Sharing Strategies and Experience

3.	 Tips for Conflict Resolution

Managing Extreme Situations I: 
Learning and Tips for Peer Outreach

Topics

Total Time

45 Minutes

TYPES OF ABNORMAL BEHAVIOURS:

Abnormal or Escalating Behaviour: when someone shows when they are 
having a heightened/high emotional response, usually to something that 
is stressful

Non-Verbal:
•	 Pacing
•	 Clenched fists
•	 Intense staring

Verbal:
•	 Negative Comments: putting others down, saying mean things
•	 Swearing
•	 Verbal Threats
•	 Screaming

Physical:
•	 Pointing/Gesturing
•	 Increased Muscle tension
•	 Hitting/Striking out 

Activity: Ask volunteers what non-verbal, verbal or physical examples 
they have seen and have them demonstrate

1

Credits: Special thank you to Bryce Koch RN, BN of Project Safe Audience

Section Time

15 Minutes

Presenter(s)

_________
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TIPS FOR CONFLICT RESOLUTION:

•	 Make sure only one person takes a lead when interacting with 
someone who is upset or agitated

•	 Validate the feelings that the person is experiencing

•	 Offer support to the person:

o “Is there anything I can do to help in this situation?”

o “How can I help you feel better/calmer…”

o “What do you need right now?”

3

SHARING STRATEGIES AND EXPERIENCE:

Ask the group:  Has anyone thought of a time when they have felt 
escalating behaviour…

•	 Have you ever noticed escalating behaviour in others?

•	 What went well?

•	 What did not work well or make things progress?

•	 How did you feel during the experience?

•	 Why do you think the person acted like this?

2

Credits: Special thank you to Bryce Koch RN, BN of Project Safe Audience

Have volunteers go in pairs (for 2 minutes) and one person share one 
story of when someone was upset or agitated and what they did or said 
that helped calm the person down. Then debrief with the group.

10 
MINUTE 
ACTIVITY

Section Time

15 Minutes

Presenter(s)

_________

Section Time

15 Minutes

Presenter(s)

_________



Managing Extreme Situations II:
Psychedelic Crisis Intervention

Lesson: pg 81-83 
45 MINUTES

RELATIONAL SKILLS



VAN CCAPO: Street Degree                                                                                                                           Relational Skills

Managing Extreme Situations| Pg 81

1.	  Understanding Psychedelic Crisis

2.	 Crisis Intervention Practices

Managing Extreme Situations II: 
Psycheledic Crisis Intervention

Topics

Total Time

45 Minutes

UNDERSTANDING PSYCHEDELIC CRISIS:

This presentation was originally designed for people who are in a 
psychedelic crisis, however, these techniques have been proven useful in 
individuals experiencing:
•	 Drug induced Psychosis
•	 Escalating Behaviour
•	 Dementia 
•	 Mental Health Crisis

It is not uncommon for psychedelic users to have difficult psychedelic 
experiences. This is most likely to happen with first-time users, with high 
doses and without adequate preparation or guidance. These experiences 
are sometimes called “bad trips.”

Common features of a 
psycheledic crisis include:
•	 the feeling/experience that 

one is going crazy/ losing 
one’s mind

•	 feeling that the experience 
will never end 

•	 old traumas can be 
remembered and relived

1 Section Time

10 Minutes

Presenter(s)

_________

Equipment 
& Materials:

Flipchart
Markers

P
P
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Credits: Special thank you to Bryce Koch RN, BN of Project Safe Audience

CRISIS INTERVENTION PRACTICES:

There are 5 main points to remember when dealing with someone whose 
mental state is changed:
1.	 Assess physical safety 
2.	 Create a safer space
3.	 Use psycho-social support
4.	 Facilitation
5.	 Ensure safety

1. Assess physical safety
Priority: Get to know the person and symptoms
•	 Breathing and heart rate
•	 Symptoms
•	 Type of substance(s) used
•	 What might be triggering for them

2. Create a Safer Space
Try to create a calm environment, and be a calm presence
Priority: Making the person comfortable
Consider:
•	 Physical environment (Sound, Temperature)

o Move the person to a quieter or more private area
•	 Social environment (Privacy)

Basic Human Needs:
•	 Water
•	 Food (Snacks or granola bar if they are alert)

2 Section Time

20 Minutes

Presenter(s)

_________
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3. Psychological support
Be a calm, supportive presence:

•	 Support where they are at (but avoid guiding)
o Let the person’s unfolding experience be 
the guide.

•	 Talk them through an event, not down
o Explore distressing issues as they emerge 
o Help the person connect with what they 
are feeling

•	 Difficult is not the same as bad
o Encourage them to explore what’s 
happening
o Challenging experiences can lead to 
growth and learning
o This difficult experience may be 
happening for an important reason 

•	 Remember that “hurt people might hurt other 
people”

•	 A crisis event or “blow out” might be an 
accumulation of many smaller events

4. Facilitation
Create a trusting relationship with the person
It is important to: 
•	 Be patient
•	 Be  positive 
•	 Be aware of any judgments you may have
•	 Know your limitations

5. Ensure Safety
Make sure person is not a threat to their self or 
others
If a violent episode happens, leave the situation
Your Safety is the most important !!!

Case study: Sean
•	 Take 5 pieces of chart paper and write each of the above points at the top of a paper.
•	 Read the scenerio, then have the group discuss how they can support Sean. 
•	 Record key points on chart paper under the 5 different headings.

	o 25-year-old male named Sean
	o Injected what they thought was heroin 
	o Drug injected actually contained a synthetic cannabinoid
	o Mental state has changed, and he has declined from coordinated movement, to stumbling around 
	o Sean appears pale, sweaty, and panicked, glancing around. His lips are dry + pupils are dilated
	o Unable to stay still for an extended period of time
	o Doesn’t know where he is. Believes his pants are wet. Seems to be dancing to music that doesn’t exist

15 
MINUTE 
ACTIVITY



Recognizing & Minimizing  
Burnout

Lesson: pg 85-87 
40 MINUTES

RELATIONAL SKILLS
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1.	 Definitions and Discssion

2.	 Tips for Preventing Burnout

Recognizing and Minimizing Burnout

Topics

Total Time

40 Minutes

DEFINITIONS:

Ask the group: What is burnout? Why do you think peers may 
experience burnout?

Burnout

•	 Physical or mental collapse caused by overwork and stress

•	 Exhaustion of physical or emotional strength or motivation usually as 
a result of prolonged stress or frustration

Physical Reactions
o Fatigue, sleep disturbances, changes in appetite, headaches, 
upset stomach, chronic muscle tension

Emotional Reactions
o Feeling overwhelmed or emotionally spent, helpless and/
or inadequate, sense of vulnerability, crying more easily of 
frequently, suicidal or violent thoughts or urges

Other Reactions
o Loss of enjoyment
o Pessimism
o Behavioral reactions such as isolation, withdrawal, increased 
mood swings, irritability, restlessness, changes with relationships 
to others
o Decreased concentration
o Difficulty making decisions or problem-solving
o Forgetfulness or impaired concentration and attention

•	 You don’t wake up one morning and all of a sudden “have burnout”. 
o Its nature is much more subtle, creeping up on us over time 
like a slow leak, which makes it harder to recognize. 
o Still, our bodies and minds do give us warnings, and if you 
know what to look for, you can recognize it before it’s too late

1 Section Time

20 Minutes

Presenter(s)

_________
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DEFINITIONS continued:

Compassion Fatigue / Secondary Traumatic Stress
•	 Characterized by a gradual lessening of compassion over time – meaning you are less sensitive to the 

physical, mental, or emotional pains of others

•	 People who experience compassion fatigue can exhibit several symptoms including hopelessness, a 
decrease in experiences of pleasure, constant stress and anxiety, sleeplessness or nightmares, and a 
pervasive negative attitude

•	 Can have detrimental effects on individuals, both professionally and personally, including a decrease 
in productivity, the inability to focus, and the development of new feelings of incompetency and self-
doubt

Vicarious Trauma

•	 When we connect with people emotionally, the exposure to the other person’s traumatic material can 
result in symptoms or disturbance such as feelings of sadness, grief, irritability and mood swings.

•	 Common signs and symptoms include, but are not limited to, social withdrawal; mood swings; 
aggression; greater sensitivity to violence; somatic symptoms; sleep difficulties; intrusive imagery; 
cynicism; sexual difficulties; difficulty managing boundaries with clients; and core beliefs and resulting 
difficulty in relationships reflecting problems with security, trust, esteem, intimacy, and control.
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TIPS FOR PREVENTING BURNOUT:

Ask the group: What do you think helps to prevent burnout? What does 
self-care look like to you?
Self Care
•	 Start the day with a relaxing ritual
•	 Adopt healthy eating, exercising, and sleeping habits
•	 Set boundaries

o Don’t overextend yourself, learn how to say “no” to requests on 
your time. If you find this difficult, remind yourself that saying “no” 
allows you to say “yes” to the things that you truly want to do.

•	 Nourish your creative side – creativity is a powerful antidote to 
burnout

•	 Learn how to manage stress

Working as a Team
•	 Team roles

o Make sure you know who does what!
o Ensure that you rotate roles and responsibilities 

•	 Create a debrief and support plan

•	 Develop connections with your team (i.e.  low stress teambuilding)

•	 Having  a good team leader or manager is important 
o Your team leader or manager should be alert to the potential for 
burnout 

•	 Create a positive narrative within your working culture focusing on 
strengths, gratitude, and what works in overdose response as a team

2 Section Time

20 Minutes

Presenter(s)

_________

Mobile Response Team Resources
The Provincial Overdose Mobile Response Team is offering free programs designed specially to support 
the physical, mental, and emotional wellness of first responders, frontline workers and people with lived 
experience/peers working on the frontline of the overdose public health emergency

Molson OPS Drop In - MRT members 
are available for people to speak with

Opportunity for people working in 
the overdose community of practice 

to meet others working in the 
community

This drop-in session is now 9-12 

Frontline Fight Club Drop in

Wed 8:30 am and Fri 9:00 am. 

All Levels Welcome

Eastside Boxing Club 238 Keefer Street

Frontline Fitness or Massage

To sign up use this link:  
https://signup.com/

group/577025885928804095 

Only available in New Westminster or 
Aldergrove

 
During COVID 
some of these 

resources may not be 
available. 

What alternatives can 
we think of?



Collective Resiliency:
Boundary Setting

Lesson: pg 89-92 
60 MINUTES
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1.	 Defining Boundaries

2.	 Tips for Boundary Setting

3.	 Skills for Boundary Setting

4.	 Friend vs. Work Relationships 

Collective Resiliency: Boundary Setting

Topics

Total Time

60 Minutes

DEFINING BOUNDARIES:

Ask the group: what do you believe boundaries are? Why are they 
useful?

Boundaries

•	 Boundaries are like invisible lines drawn to define limits.

•	 Boundaries affect how a group interaction will work and include 
limits which exist around people, time, space, and the work of the 
interaction/group.

•	 It is often easier to understand where a boundary exists when it has 
been broken.

•	 Boundaries are an essential part of our relationships – this is 
especially true in a situation where personal details are being shared 
and trust is being built.

•	 Boundaries are inherently linked to the idea of respect.

•	 Sometime in an effort to appease, we may allow certain actions or 
behaviours to go on without stopping them for a fear of upsetting or 
even losing a relationship.

o Unfortunately, this can set a precedent that can lead to issues 
further down the road.

1 Section Time

10 Minutes

Presenter(s)

_________
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TIPS FOR BOUNDARY SETTING:

Ask the group: what have you found effective in setting boundaries in 
your relationships? What are some situations you’ve found it difficult to 
set boundaries in?

Tips for Boundary Setting

•	 Know what limits are important before starting out.
o It’s hard to set boundaries with someone when they aren’t 
clear personally
o Identify comfortable physical, mental and emotional limits for 
yourself.

•	 Do not allow anyone to take advantage of your time.
o Starting late or staying late are only options in extremes, not 
given alternatives to your schedule.

•	 Communicate effectively and be direct.
o Some people will naturally have similar communication styles 
and understand without specific dialogue to guide them, others 
will not.

•	 Be assertive.
o This is especially important if control is being lost, or someone 
is stepping over set boundaries.
o Occasionally people are unaware, but sometimes they just 
need a firm reminder of your boundaries.

•	 Learn to say no and mean it.
o Make sure to say no to activities that may take up too much 
time or energy and can cause burn out.

•	 Set expectations.
o Ensure that you identify working times and when folks can 
expect responses or follow up.

•	 Do not feel guilty to set boundaries.
o Some people may use manipulation or guilt to change a 
boundary they don’t particularly like, but this should never be 
allowed to happen.
o Some people may be better served by someone else if they 
continue to ignore your boundaries.

2 Section Time

15 Minutes

Presenter(s)

_________
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5 SKILLS FOR SETTING BOUNDARIES:

1. Ensure You have Set Policies
•	 Discuss what the boundaries of your relationship are before any 

altercation takes place – “everyone in our group must arrive on time 
to be paid”.

•	 It is often better to set these policies collectively.

2. Name the Behaviour

•	 Name the behaviour might be as simple as stating – “you keep 
arriving late for our sessions”.

3. Give a Directive
•	 Tell the person exactly what you want them to do, as concisely and 

clearly as possible.
•	 For example:

o “Please ensure you give me enough notice when you are 
running late.”
o “I ask you respect my time by being on time as well.”

4. Repeat It
•	 Stay focused on the directive you are giving and don’t let yourself be 

diverted until it is respected.
•	 Call it a broken record or a skipping CD – this skill is about 

demonstrating persistence.

5. End It
•	 Sometimes all the good boundary setting you’ve been doing does not 

yield the desired results.
•	 You are not in control of how other people act and respond to 

you, and sometimes people are just not willing to respect your 
boundaries.

•	 This may mean that you get up and leave and seek out someone in 
the environment to assist you in ending the interaction, or end a 
relationship where your boundaries are repeatedly disrespected.

Ask the group: what may be useful or difficult about these skills?

3 Section Time

15 Minutes

Presenter(s)

_________
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ACROSS THE ROOM ACTIVITY

Find a partner, line up in tow rows about 10-15 feet apart, facing each other. One of you 
will be in row 1, the other will be in row 2.

Round 1: Non-Verbal Expression
•	 Everyone in row 1 will pick a spot on the floor that they do not want to be crossed - 

keep the location to yourself!
•	 When the facilitator says “go”, participants in row 2 will walk towards the partner they 

are facing.
•	 When your partner reaches your secret boundary spot, use your body language to 

indicate that you don’t want them any closer.
•	 Then, switch positions!

Round 2: Verbal and Non-Verbal Expression
•	 This time, use your voice and your body language to indicate to your partner not to 

cross your secret boundary.

Round 3: Reinforcing a Crossed Boundary
•	 This time, use your body language and voice (tone, volume, inflection) to practice re-

setting the boundary.
•	 Inform your partner of the boundary and re-setting positions.

Discussion: which round did you find hardest to do? Which one was easiest? Could you see 
yourself using these skills in real life?

Activity 
Time

10 Minutes

FRIEND VS. WORK RELATIONSHIP:

Ask the group: why are boundaries between friendly and workplace 
relationships become blurry when engaging in peer work?

4 Section Time

10 Minutes

Presenter(s)

_________



Reducing Stigma

Lesson: pg 94-96 
45 MINUTES
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1.	 Understanding Stigma

2.	  Stigma and the Role of Service

3.	 Options and Opportunities

Reducing Stigma

Topics

Total Time

45 Minutes

UNDERSTANTING STIGMA:

Ask the group: What is stigma? What is stigma against drug users?

Social Stigma

•	 Social stigma is the disapproval of, or discrimination against, a person 
based on perceivable social characteristics that serve to distinguish 
them from other members of a society.

•	 Social stigmas are commonly related to culture, gender, race, 
intelligence, and health

Drug User Stigma Strong disapproval and negative judgements toward 
people who use drugs 

Structural Stigma

•	 Structual stigma is the distrimination that we face from institutions - 
like at the hospital or when trying to receieve government assistance. 

•	 When we are discriminated against by health care and social services 
it creates a major barrier to receiving the supports we need to stay 
healthy and survive.

•	  Stigma can affect our ability to find housing and jobs, which in turn 
affects our overall health and quality of life.

•	 When people who use drugs face stigma in the health system, it 
reduces the quality of care we receive and our legitimate health 
concerns are often ignored or our drug use is blamed. 

•	 It also makes us less likely to follow through on a treatment program 
(related to drug use, or other health issues), out of fear we will face 
stigma again.

1 Section Time

20 Minutes

Presenter(s)

_________
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STIGMA AND THE ROLE OF SERVICE:

Shelter Scenario:

R has been staying at the same shelter for two months. The shelter’s 
policy is to hold harm reduction supplies overnight and return them in the 
morning. R has not always abided by this policy, because the shelter is the 
safest place in which she can use. 

As a result, R has had conflicts with a staff member who doesn’t 
understand why she sometimes injects inside the shelter. This staff 
member constantly monitors R’s behaviour, and shares his negative 
perceptions of R with a new staff member. 

The new staff member decides she needs to get to know R, and develop a 
supportive relationship based on her own understanding of R’s needs.

Discussion: Behaviours

1. How did the first staff member or second staff member’s behaviour 
positively or negatively affect the situation?

2. What might have motivated each person to behave the way they did?

3. What are the possible outcomes of each person’s behaviours?

Discussion: The Service

1. How did the design of the Harm Reduction Service positively or 
negatively affect the outcome of the situation?

2. Why might the service be set up that way?

3. What are some possible outcomes of the way the service was set up?

Ask the group:  How might stigma contribute to negative outcomes for 
people?

Consider:
•	 Internal stigma
•	 Stigma in relationships
•	 Stigma in organizations (institutions, government, society)
•	 Stigma in how people communicate

2 Section Time

15 Minutes

Presenter(s)

_________
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OPTIONS AND OPPORTUNITIES:

Ask the group: How might we be able to contribute to improving the
outcomes of situations involving stigma?

Ask the group: What could leaders and management change to 
produce a positive outcome in situations involving stigma?

Stigma busting tips:

•	 Develop supportive relationships with people

•	 Work collaboratively to coordinate care and ensure safety

•	 Provide training, ongoing education and supports to employees

•	 Implement policies and regulations that protect the rights of 
vulnerable populations accessing social services

•	 Promote the rights of vulnerable populations accessing services

•	 Support and mentor other peers who are experiencing challenges

•	 Provide education to others about your experiences when 
accessing health and social services

3 Section Time

10 Minutes

Presenter(s)

_________



Strengths Based Care

Lesson: pg 98-102 
60 MINUTES
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1.	 What is Trauma?

2.	 Trauma and Substance Use

3.	 Trauma Informed Care

4.	 Key Principles

5.	 Implications

Strengths Based Care

Topics

Total Time

60 Minutes

WHAT IS TRAUMA?

Ask the group: what is trauma? What are some of the effects of trauma?

Trauma is defined as experience that overwhelms an individual’s capacity 
to cope

•	 Trauma can occur early in life—for example, as a result of child 
abuse, neglect, witnessing violence and disrupted attachment—or 
later in life due to violence, accidents, natural disasters, war, sudden 
unexpected loss and other life events that are out of one’s control

	o Experiences like these can interfere with a person’s sense of 
safety, self and self-efficacy, as well as the ability to regulate 
emotions and navigate relationships

	o Social stigma such as racism, sexism, homophobia, and 
stigma against the poor and drug users can lead certain 
demographics of people to experience more violence and hence 
have a greater likelihood of experiencing trauma

	o Traumatized people commonly feel terror, shame, 
helplessness and powerlessness

•	 Trauma is both an event and a particular response to an event; 
post-traumatic stress disorder is one type of “disorder” that results 
from trauma

•	 Trauma can be life changing, especially for those who have faced 
multiple traumatic events, repeated experiences of abuse or 
prolonged exposure to abuse

	o Even the experience of one traumatic event can have 
devastating consequences for the individual involved

1 Section Time
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TRAUMA AND SUBSTANCE USE:

Ask the group: why might trauma and substance use be related?

•	 It is very common for people accessing substance use treatment 
and mental health services to report overwhelming experiences of 
trauma and violence

•	 Some people who have experienced trauma view their use of 
substances as beneficial in that it helps them to cope with trauma-
related stress

	o This adaptive coping mechanism can make people more 
vulnerable to substance use problems

•	 It is important to remember that, for many people, using drugs 
feels good

	o Not all drug use is a trauma response!

2 Section Time

10 Minutes

Presenter(s)

_________

TRAUMA INFORMED CARE:

Ask the group: what do you believe we mean when we talk about 
Trauma Informed Care? How can we prioritize people with trauma when 
we provide assistance to people?

Trauma Informed Approaches to Care

•	 Trauma-informed services take into account an understanding of 
trauma in all aspects of service delivery and place priority on trauma 
survivors’ safety, choice and control

•	 “What has happened to this person?” rather than “What is wrong 
with this person?”

•	 Trauma informed approaches to care stress nonviolence, learning 
and collaboration

•	 Working in a trauma-informed way does not necessarily require 
disclosure of trauma – rather, services are provided in ways that 
recognize needs for physical and emotional safety, as well as choice 
and control in decisions affecting one’s treatment

•	 In trauma-informed services, there is attention in policies, 
practices and staff relational approaches to safety and empowerment 
for the service user

	o Safety is created in every interaction and confrontational 
approaches are avoided

3 Section Time
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TRAUMA INFORMED CARE continued:

•	 Trauma-specific services more directly address the need for healing from traumatic life experiences 
and facilitate trauma recovery through counselling and other interventions

•	 It could be said that trauma-informed approaches are similar to harm-reduction-oriented 
approaches in that they focus on safety and engagement

•	 In trauma-informed contexts, building trust and confidence pave the way for people to consider 
taking further steps toward healing while not experiencing further traumatization

KEY PRINCIPLES:

Trauma Awareness:

•	 All services taking a trauma-informed approach begin with building 
awareness of: 

	o How common trauma is
	o How its impact can be central to one’s development
	o The wide range of adaptations people make to cope and 

survive
	o The relationship of trauma with substance use, physical 

health and mental health concerns

Emphasis on Safety and Trustworthiness: 

•	 Physical and emotional safety for clients is key to trauma-informed 
practice because trauma survivors often feel unsafe, are likely to have 
experienced boundary violations and abuse of power, and may be in 
unsafe relationships

•	 Safety and trustworthiness are established through activities such as: 
	o Welcoming intake procedures
	o Exploring and adapting the physical space
	o Providing clear information about the programming
	o Ensuring informed consent
	o Creating crisis plans
	o Demonstrating predictable expectations
	o Scheduling appointments consistently

4 Section Time
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KEY PRINCIPLES continued:

Opportunity for Choice, Collaboration and Connection: 

•	 Trauma-informed services create safe environments that foster a client’s sense of self-determination, 
dignity and personal control

•	 Service providers try to communicate openly, equalize power imbalances in relationships, allow the 
expression of feelings without fear of judgment, provide choices as to treatment preferences, and work 
collaboratively

•	 Having the opportunity to establish safe connections— with treatment providers, peers and the 
wider community—is reparative for those with early/ongoing experiences of trauma

•	 This experience of choice, collaboration and connection is often extended to client involvement in 
evaluating the treatment services, and forming consumer representation councils that provide advice 
on service design, consumer rights and grievances

Strengths-Based and Skill Building

•	 Clients in trauma-informed services are assisted to identify their strengths and to further develop 
their resiliency and coping skills

•	 Emphasis is placed on teaching and modelling skills for recognizing triggers, calming, and centering  

Ask the group:  have you ever provided assistance to someone while prioritizing their trauma? What did 
that look like?
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IMPLICATIONS:

Specific Populations and Trauma

•	 A key aspect of trauma-informed practice is understanding how 
trauma can be experienced differently by refugees, people with 
developmental disabilities, women, men, children and youth, 
Indigenous peoples, and other populations

•	 Of particular note is the increasing understanding of the impact of 
historical and intergenerational trauma for Aboriginal peoples in 
Canada, and the implications for trauma-informed care for Aboriginal 
peoples as part of a broad approach to policy, treatment and 
community interventions

Providing Care and Trauma

•	 Trauma-informed services demonstrate awareness of vicarious 
trauma and staff burnout

•	 Many providers have experienced trauma themselves and may be 
triggered by client responses and behaviours

•	 Key elements of trauma-informed services include staff education, 
clinical supervision, and policies and activities that support staff self-
care

5 Section Time
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1.	 The Basics of Effective Communication

2.	 Communication Skills

3.	 The Spirit of Motivational Interviewing

4.	 “Ask Tell Ask”

5.	 Communication in Conflict Situations

Communication Skills

Topics

Total Time

65 Minutes

THE BASICS OF EFFECTIVE COMMUNICATION:

What is Communication?

•	 Communication is simply the act of transferring information from 
one place, person or group to another.

•	 Every communication involves (at least) one sender, a message and 
a recipient.

•	 The transmission of the message from sender to recipient can be 
affected by a huge range of things which impact how the message is 
received.

	o These include our emotions, the cultural situation, the 
medium used to communicate, and even our location.

	o People’s culture and values can impact the way they 
understand things and the way in which they try to 
communicate things.

•	 The different categories of 
communication include:

	o Spoken or verbal communication
	o Non-verbal communication
	o Written communication
	o Visualizations

Ask the group: What do people in the 
rooms feel makes for effective or ineffective 
communication?

1 Section Time
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THE BASICS OF EFFECTIVE COMMUNICATION continued: 

Non-Verbal Communication

•	 Body movements, for example, hand gestures or nodding or shaking the head, which are often the 
easiest element of non-verbal communication to control

•	 Posture, or how you stand or sit, whether your arms are crossed, and so on

•	 Eye contact, where the amount of eye contact often determines the level of trust and 
trustworthiness

•	 Para-language, or aspects of the voice apart from speech, such as pitch, tone, and speed of speaking

•	 Closeness or personal space (proxemics), which determines the level of intimacy, and which varies 
very much by culture

•	 Facial expressions, including smiling, frowning and blinking, which are very hard to control 
consciously.

•	 Physiological changes, for example, you may sweat or blink more when you are nervous, and your 
heart rate is also likely to increase. 

•	 The Cultural Context
	o The good news is that most of us learn to interpret non-verbal communication as we grow up 

and develop. It is a normal part of how we communicate with other people, and most of us both 
use it and interpret it quite unconsciously.

	o This can make it harder to interpret consciously. However, if you stop thinking about it, you will 
probably find that you have a very good idea of what someone meant.

	o The bad news is that non-verbal communication can be very culture-specific

Example: the thumbs-up gesture generally signals approval in English-speaking countries, 
but is considered offensive in Greece, Italy and parts of the Middle East.
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Ask the group: what do people in the rooms feel makes for intimidating non-verbal communication? What 
do folks feel may be less threatening?

Common barriers to communication

•	 The use of jargon. Over-complicated, unfamiliar and/or technical terms.

•	 Emotional barriers and taboos. Some people may find it difficult to express their emotions and some 
topics may be completely ‘off-limits’ or taboo. Taboo or difficult topics may include, but are not limited 
to, politics, religion, disabilities (mental and physical), sexuality and sex, racism and any opinion that 
may be seen as unpopular.

•	 Lack of attention, interest, distractions, or irrelevance to the receiver. 

•	 Differences in perception and viewpoint.

•	 Physical disabilities such as hearing problems or speech difficulties.

•	 Physical barriers to non-verbal communication. Not being able to see the non-verbal cues, gestures, 
posture and general body language can make communication less effective. Phone calls, text messages 
and other communication methods that rely on technology are often less effective than face-to-face 
communication.

•	 Language differences and the difficulty in understanding unfamiliar accents.

•	 Expectations and prejudices which may lead to false assumptions or stereotyping.  People often hear 
what they expect to hear rather than what is actually said and jump to incorrect conclusions. Our page 
The Ladder of Inference explains this in more detail.

•	 Cultural differences.  The norms of social interaction vary greatly in different cultures, as do the way 
in which emotions are expressed. For example, the concept of personal space varies between cultures 
and between different social settings.
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COMMUNICATION SKILLS:

Ask the group: what is the difference between listening to someone and 
hearing them?

Ask the group: has there been a time where your communication style 
didn’t work out for you? What skills do folks think can help improve your 
interactions?

Role of listening and active listening

•	 ‘Active listening’ means, as its name suggests, actively listening. 
That is fully concentrating on what is being said rather than just 
passively ‘hearing’ the message of the speaker.

•	 Active listening involves listening with all senses.  As well as giving 
full attention to the speaker, it is important that the ‘active listener’ is 
also ‘seen’ to be listening - otherwise the speaker may conclude that 
what they are talking about is uninteresting to the listener.

•	 Interest can be conveyed to the speaker by using both verbal and 
non-verbal messages such as maintaining eye contact, nodding your 
head and smiling, agreeing by saying ‘Yes’ or simply ‘Mmm hmm’ to 
encourage them to continue.  By providing this ‘feedback’ the person 
speaking will usually feel more at ease and therefore communicate 
more easily, openly and honestly.

•	 Listening is not something that just happens (that is hearing), 
listening is an active process in which a conscious decision is made to 
listen to and understand the messages of the speaker.

•	 Listeners should remain neutral and non-judgmental, this means 
trying not to take sides or form opinions, especially early in the 
conversation.  Active listening is also about patience - pauses and 
short periods of silence should be accepted.

•	 Listeners should not be tempted to jump in with questions or 
comments every time there are a few seconds of silence. Active 
listening involves giving the other person time to explore their 
thoughts and feelings, they should, therefore, be given adequate time 
for that

2 Section Time
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_________
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Reflections

•	 However good you think your listening skills are, the only person who can tell you if you have 
understood correctly or not is the speaker.  Therefore, as an extension of good listening skills, you 
need to develop the ability to reflect words and feelings and to clarify that you have understood them 
correctly.  

•	 Reflecting is the process of paraphrasing and restating both the feelings and words of the speaker.  
The purposes of reflecting are:

	o To allow the speaker to ‘hear’ their own thoughts and to focus on what they say and feel.
	o To show the speaker that you are trying to perceive the world as they see it and that you are 

doing your best to understand their messages.
	o To encourage them to continue talking.

•	 Reflecting
	o Reflecting does not involve you asking questions, introducing a new topic or leading the 

conversation in another direction.  Speakers are helped through reflecting as it not only allows 
them to feel understood, but it also gives them the opportunity to focus their ideas.  This in turn 
helps them to direct their thoughts and further encourages them to continue speaking.

•	 Paraphrasing
	o Paraphrasing involves using other words to reflect what the speaker has said.  Paraphrasing 

shows not only that you are listening, but that you are attempting to understand what the 
speaker is saying.

Clarification

•	 In communication, clarification involves offering back to the speaker the essential meaning, as 
understood by the listener, of what they have just said. Thereby checking that the listener's 
understanding is correct and resolving any areas of confusion or misunderstanding.

•	 Clarification is important in many situations especially when what is being communicated is difficult 
in some way. Communication can be 'difficult' for many reasons, perhaps sensitive emotions are being 
discussed - or you are listening to some complex information or following instructions.

•	 Some examples of non-directive clarification-seeking questions are:
	o “I'm not quite sure I understand what you are saying.”
	o  “I don't feel clear about the main issue here.”
	o “When you said ........ what did you mean?”
	o “Could you repeat ...?”

•	 Clarifying involves:
	o Non-judgemental questioning.
	o Summarising and seeking feedback as to its accuracy.
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THE SPIRIT OF MOTIVATIONAL INTERVIEWING:

Four Central Pillars

•	 Compassion: caring about what is important to another person 
and feeling moved to help.

•	 Acceptance: Respecting another person and their right to change 
or not change.

•	 Partnership: Working together with the other person and 
recognizing them as equal.

•	 Evocation: Bringing out another’s ideas, strengths and knowledge 
about the situation and themselves, this can include encouraging 
them to explore.

3 Section Time
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ASK TELL ASK:

What is Ask-Tell-Ask?

•	 Ask-tell-ask is important when delivering person centred care.

•	 Rather than telling an individual a lot of information, we ask if 
they’d like to here it, tell, then ask if they’d like clarification:

	o Ask what they know and what they want to know.
	o Tell them what they want to know. 
	o Ask them if they understand and what else they want to 

know.

Ask

•	 Always ask permission to start the conversation.

•	 Ask the person to describe their understanding of their problem. 
This will help tailor the conversation to the person’s level of 
understanding and emotional state.

•	 Asking helps you determine the agenda for the conversation 
because you understand what the person hopes to accomplish.

Tell

•	 Provide simple information that the person wants to know, using 
only a few short sentences.

•	 Share information that you understand.

•	 Use simple language the person will understand, not complicated 
terminology or jargon.

Ask again

•	 Confirm understanding by asking the person to repeat back what 
was just explained in their own words.

•	 Ask if the person has any questions or wants to know anything 
else.

Section Time
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Activity:

•	 Please get into groups of 3. (One option is to count 1, 2, 3 then 1, 2, 3 all around the room or if you 
have a count of everyone present divide the total by 3 and count off by the number you get, then have 
the three “1s” gather as partners, the three “2s”, etc. The second option will mix the group up more.)

•	 This activity has 5 parts, and is a ROLE PLAY of a real work situation.

1.	 Work in trios.

2.	 Think about some messages you frequently give.

3.	 Practice giving those messages using Ask-Tell-Ask. One of you will be yourself giving the message, 
one will be role playing whoever you work with, and one of you will be the observer. 

	o When you are playing yourself please tell your partner a bit more about the situation so 
they know how to play the role. 

	o For example, “you are a young woman who is a daily crystal meth user and we are talking 
about recovery.”

4.	 Take turns.

5.	 Debrief the activity and be ready to share what you learned.

•	 The observer role is special. If we don’t “see” the results of what we are trying, it’s hard to learn, 
that’s like shooting an arrow with a blindfold on, we don’t know if we’ve hit the target. The observer is 
going to be watching for what works, what doesn’t seem to work in this case, and then everyone will 
work together on any suggestions for improvement, if necessary.

Activity Debrief:

Let’s hear from each group. 

•	 What did you observe about using ask-tell-ask?

•	 Can you imagine using these in practice?

•	 What works easily for you?

•	 What might require more practice?
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COMMUNICATION IN CONLICT SITUATIONS:

Two types of difficult conversations

•	 Planned conversations occur when the subject has been given 
thought, they are planned as the time, place and other circumstances 
have been arranged or are chosen for a reason.

	o Although these situations are, by their nature, difficult they 
are controlled and as long as time has been taken to prepare 
and think properly about how others may react they can often 
end up being easier than imagined.

•	 Unplanned difficult conversations take place on the spur of the 
moment; these are often fuelled by anger which can, in extreme 
cases, lead to aggression.

There are two main factors that make communication seem difficult: 
emotion and change.

Ask the group: what are some ways we can approach unplanned 
conversations that are tinged with anger or aggression?

The First Line of Defence is Self-Control

•	 Aggression is often associated with deep emotional responses: it is 
a reaction to threats, or anger. It therefore triggers an emotional 
response in other people.

•	 If you are going to deal effectively with aggression in others, it is 
important that you understand and can manage your own emotional 
responses.

•	 To develop an understanding of aggressive behaviour, it is 
important for people to recognise their own feelings and how they 
react and deal with aggression—both within themselves and in 
others. The first line of defence is very definitely not attack, in this 
case—it is self-control.

•	 Listening to people, and treating them as human beings, can go a 
very long way to helping you to defuse aggression in others. Very few 
people actually want to be angry and aggressive.

Section Time
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COMMUNICATION IN CONLICT SITUATIONS continued:

The Importance of Listening and Accepting

•	 We all want to be listened to, especially when we are talking about something that is important to us.

•	 One of the main triggers for aggression is a feeling of frustration or anger.

•	 Individuals are less likely to become aggressive if they:
	o Feel safe and unthreatened
	o Expect to be treated with respect, perhaps because of previous experience in that environment 

or with that person
	o Understand the behaviour that is expected, or the social norms
	o Are able to communicate effective
	o Are in a calm environment, where most people feel comfortable, and where people are treated 

with respect.

Defusing Aggression in Others

•	 There are a number of techniques for dealing with aggression, including both verbal and non-verbal 
behaviours.

•	 Non-verbal behaviours that can help to defuse aggression include:
	o Being aware of your own body language and showing a non-threatening, open stance.
	o Keeping good eye contact but ensuring this does not appear confrontational.
	o Moving slowly and steadily. Try to keep your physical movements calm.
	o Respecting the other person’s personal space.

•	 Verbal behaviours that will help to encourage assertive responses include:
	o Listening to what the other person has to say and accepting, recognising and emphasising 

positive aspects of what is being said—without minimising the negatives.
	o Showing respect through polite formalities, but aiming to work towards familiarity.
	o Showing understanding and empathy with the person by reflecting, clarifying and summarising 

their thoughts and feelings.
	o Avoiding any expression of power, for example “You must calm down”.
	o Encouraging the other person to take responsibility for their own behaviour and to direct it into 

more creative or positive outlets, e.g., by making a written complaint rather than verbally 
criticising someone/an organisation.
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1.	 The Importance of Co-Facilitation

2.	 Skills for Successful Faciliation

Facilitation Skills

Topics

Total Time

30 Minutes

THE IMPORTANCE OF CO-FACILITATION:

Ask the group: how do you feel when you’re presenting alone as 
opposed to with someone else?

To be more comfortable teaching courses like Overdose Prevention, 
Response, and Naloxone Administration, it often helps to co-facilitate. 

•	 Working with other trainers allows us to support each other with-
in our best capacities.

•	 Working with a co-facilitator can relieve some of the pressure or 
stress of presenting alone

•	 Presenting together can give a more fun, in-depth discussion 
leading to good questions and more audience participation

•	 Co-facilitating allows for the other person’s eyes and ears to catch 
something that may get missed, and helps to get the group into 
deeper discussion to maximize what the participants learn

•	 Participants may be especially good at reading a group to know 
where their energy and commitment levels for training are.

1 Section Time
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SKILLS FOR SUCCESSFUL FACILITATION:

Ask the group: What has helped people in the room facilitate in the 
past? What do you feel makes a good session? 

Ask the group: What do I need to facilitate or co-facilitate successfully?
•	 Orientation and preparation on the subject
•	 Goals and objectives of the session
•	 Knowledge of the topic being trained or to be taught
•	 Understanding of room set-up and resources
•	 Discussion with co-presenter prior to the session

Review Handouts

•	 FACILITATION CHEAT SHEET

•	 CO-FACILITATION GUIDELINES

•	 CO-FACILITATOR CHECKLIST

2 Section Time

20 Minutes
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1. Create the Space

Make sure you have a comfortable 
room, ensure there are enough breaks, 
and bring food if possible.

Try to create a safer space.

2. Before you Start
Have participants involved right 
away – set up group guidelines and 
introductions.

3. Conflict in the Group 
It’s okay to disagree. Try to 
acknowledge the different ideas in the 
room.

4. Question Posing Asking the audience questions is a 
great way to keep them engaged.

5. Active Listening Summarize what people have said.

6. Participants Talking

Over Each Other

Create group guidelines at the 
beginning, use a talking stick if 
necessary.

7. One Person Taking Up Too 
Much Space

Summarize their point, be directive, 
and ask for other people’s opinions.

8. Shy Participants

Ice breakers; small group work; “pair 
and share” – turn to person next to 
you and share. Have people write ideas 
down on paper and facilitator reads 
out.

Facilitation Cheat Sheet
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1.	 Check in with each other in advance. As soon as you 
know you will be working with each other, get together to 
plan. You need to agree on the timing, who will do which 
sessions and what roles and responsibilities you each 
have.

2.	 Tell your co-trainer what you expect and need. The first 
time you meet, tell each other what you expect from a co-
trainer and how you work best. Everyone has a different 
understanding of co-training and this needs to be shared 
before you work together.

3.	 Check in with each other during the training. When 
possible and necessary during each session, check in with 
each other briefly. Sometimes, for example, you just need 
to tell the person you are going to end early or that you 
will need paper, but sharing this information can help the 
flow of the workshop and minimize frustration. The best 
time to check in with each other is during breaks. Avoid 
talking to one another when learners are working on their 
own rather than listening attentively to the dialogue.

4.	 Check in with each other before and after the training. 
Before the training you need to check in with each other 
about what you are planning to do and if anything has 
changed since you last spoke. After the training you need 
to check in to share your thoughts on how the session 
went, what needs to change in the following session, 
and what could be done better next time. Because ‘the 
unexpected’ can always happen, checking in before and 
after a session is critical. This is also a great time to affirm 
each other.

5.	 Support your co-trainer. While your co-trainer is leading 
an activity you should be fully attentive to what he or she 
needs and what the group may need that you can best 
do. Helping your co-trainer hand out paper, support a 
confused working group or tape something on the wall, 
can help him or her be more focused on the task at hand 
and keep up the energy of the group.

6.	 Don’t interfere. While your co-trainer is leading an 
activity, don’t interfere or contradict him or her (unless 
it is critical to the learning). You need to stay focused on 
what is happening so that you can support your co-trainer 
without being an interference or burden.

7.	 Set personal and team goals. Before you teach, name 1-2 
things you want to remember and work on in the session. 
If you share these with your co-trainer, you can also get 
feedback on these goals at the end of the session. Setting 
team goals is also a great idea.

8.	 Stay on time. Always try to stay within your delegated 
time frame. The sessions are often scheduled for a short 
amount of time, where every minute is valuable and 
accounted for. If you use more than your allotted time, it 
will impact your co-trainer’s activity and the learning that 
needs to happen.

9.	 Affirm each other. Whenever possible and true, affirm 
your co-trainer. Everyone feels nervous about teaching, 
especially to peers. You need to take every opportunity to 
tell your co-trainer what he/she is doing well.

10.	 Work as a team. You want learners to see the two of you 
as “a team.” Support each other, talk positive about each 
other in front of the group, and weave the work your co-
trainer did into your work.

CO-FACILIATION 
GUIDELINES

Retrieved from: https://www.nationalcollege.org.uk/transfer/open/facilitation/fac-s7/fac-s7-t2.html
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Get an editable version of 
this list, and other facilitator 
resources, free at 
www.facilitating.xyz

CO-FACILITATOR CHECKLIST
25+ things to ask your co-fac, and find common ground on, 

before you get in front of a group.

CONTEXT 
❏ What experiences do you have facilitating? Facilitating similar material?
❏ What are your triggers?

❏ How can we let the other know we are feeling triggered?
❏ How best can we support each other when triggered? 
❏ How can we avoid triggering one another?

CONTENT 
❏ What content are you excited to lead or feel most confident about?
❏ Is there any content you are not comfortable talking about? 
❏ Are there any styles of engagement or types of activities you’re more or 

less comfortable with? 
❏ What are our rules around personal disclosure or sharing? Are we, as 

facilitators, comfortable sharing personal stories, identities, experiences, 
etc.? 

❏ How much time are we planning to allocate to each component?
❏ What are our “wins” (overall goals) for the facilitation?

❏ What are our small “wins” for each individual component? How do 
we know when to move on, or when to stick?

PROCESS 
❏ Who is responsible for what preparation? 
❏ Is one person going to lead the facilitation, or are we going to trade off 

lead roles for each component or activity?
❏ Are we chiming in when the other is leading? 
❏ Are you okay with being corrected, or will that throw you off? 

How would you prefer to be corrected?
❏ Is staying on time important to you? Who is going to keep track of time? 
❏ What participant feedback do we want to ask for? 
❏ Do we want to do feedback with each other? If so, what feedback do we 

want, how do we want to give it, and when?
“WHAT IF…” 
❏ How do we want to check in with each other throughout the facilitation?

❏ Do you want to come up with a super secret signal? (e.g., to alert 
about time or to move the discussion forward)

❏ What are we willing to cut (e.g., for time or if a situation calls for a 
different direction)?
❏ What do we need to cover? 

❏ What activities or components do we have in our back pocket in case we 
need them?

❏ Are we doing anything that is risky? Do we have appropriate medical or 
psychological support ready if we need it? Who is responsible for what if 
that is needed?

This conversation will likely 
take 45 - 60 minutes. 
Checking each of these 
boxes will help you prevent 
a lot of co-facilitation 
hiccups.

These themes are broad, but 
hit at the major points to 
structure your discussion 
around. Context about one 
another, the content you’ll 
be facilitating, the process 
you’ll employ to facilitate it, 
and anticipating “what if…” 
situations that might derail 
the experience.

Add or remove questions (or 
sections) based on your 
relationship, and what 
you’re facilitating.



COMPUTER LITERACY

InDesign Basics:
Creating a Zine

Lesson: pg 121-145 
60 MINUTES
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1.	 How to Set Up the Zine Document in Indesign

2.	 How to Edit Your Zine’s Master Pages

3.	 How to Section Your Zine

4.	 How to Create a Front Cover for Your Zine

5.	 How to Build Up Content on the Inside Pages of Your Zine

6.	 How to Export Your Zine for Print

InDesign Basics:
Creating a Zine

Topics

Total Time

60 Minutes

1.	 Computer 

2.	 Projector

3.	 InDesign Software

4.	 Zine Examples

•	 Provide packages of pages 122 - 145 for participants.

•	 Ideally participants will have computers to follow along and make their own 
document during the training.

Materials Needed:

Equipment 
& Materials:

Photocopies  
of handouts
Computer
Projector

P

P

P
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HOW TO SET UP THE ZINE  
DOCUMENT IN INDESIGN

Open InDesign and go to File > New > Document.

Set up the document for Print, with a Half Letter page size. Set the number of pages to 10 and make sure 
Facing Pages is checked.

Add a Top and Bottom Margin of 19 mm, set the Inside Margin to 21 mm and the Bottom Margin to 25 mm.

Finally, add a 5 mm Bleed to all edges except the Inside edge, and click Create.

Step 1

1
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Expand the Layers panel (Window > Layers).

Double-click on Layer 1 and rename this Color.

Create two more new layers—Photos, and Type.

Step 2

You can spell-check a selected range of text, in all of the text in a story, in all stories in a document, or in 
all stories in all open documents. Misspelled or unknown words, words typed twice in a row (such as “the 
the”), and words with possible capitalization errors are highlighted. In addition to checking the spelling in a 
document, you can also enable dynamic spelling so that potentially misspelled words are underlined while you 
type.

When you check spelling, the dictionary for the languages you assigned to the text is used. You canquickly add 
words to the dictionary.
Set spelling preferences

1. Choose Edit > Preferences > Spelling (Windows) or InDesign > Preferences > Spelling (Mac OS).
2. Do any of the following:

o Select Misspelled Words to find words that do not appear in the language dictionary.
o Select Repeated Words to find duplicate words such as “the the.”
o Select Uncapitalized Words to find words (such as “germany”) that appear in the dictionary only 
as capitalized words (“Germany”). 
o Select Uncapitalized Sentences to find uncapitalized words following periods, exclamation points, 
and question marks.

3. Select Enable Dynamic Spelling to underline potentially misspelled words while you type.
4. Specify the underline color of misspelled words (words not found in the user dictionaries), repeated words 
(such as “the the”), uncapitalized words (such as “nigeria” instead of “Nigeria”), and uncapitalized sentences 
(sentences that don’t begin with a capital letter).

Step 3



VAN CCAPO: Street Degree                                                                                                                      Computer Literacy

Indesign Basics| Pg 124

Expand the Swatches panel (Window > Color > Swatches).
Choose New Color Swatch from the panel’s drop-down menu (at top-right).
With the Type set to Process and Mode to CMYK, set the levels below to C=96 M=82 Y=3 K=0.
Click Add and Done.
Create a second new swatch, C=0 M=86 Y=89 K=0.

Step 4
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Choose New Gradient Swatch from the Swatches panel’s menu.

Step 5

Name the swatch Gradient Swatch. Click on the left-hand stop on the Gradient Ramp, and choose

your blue swatch, C=96 M=82 Y=3 K=0, from the Stop Color menu.

For the right-hand stop choose your red swatch, C=0 M=86 Y=89 K=0.

Click Add and Done.
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Double-click on the A-Master icon at the top of the Pages panel (Window > Pages) to bring up the master on 
your screen.

Step 1

2 HOW TO EDIT YOUR ZINE’S MASTER PAGES

Use the Type Tool (T) to create a text frame across the bottom of the left-hand page.
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Here you can place page numbers. With your type cursor in the frame, go to Type > Insert Special Character > 
Markers > Current Page Number.

You can format the page number using the Swatches panel and Character and Paragraph panels (Window > 
Type & Tables > Character / Paragraph).
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Edit > Copy and Edit > Paste the page number text frame, moving this over to the right-hand page.

Step 2

Use the Rectangle Tool (M) to create a tall, narrow shape across the left edge of the spread, taking it up to the 
bleed, and allowing a small area to extend onto the page.

Set the Fill Color of this to Gradient Swatch.

Step 3
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Copy and Paste the rectangle, and on the copy, Right-Click > Transform > Flip Horizontal.

Move this over into a mirrored position on the right-hand page.
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In the Pages panel Right-Click on the A-Master icon, and choose Duplicate Master Spread “AMaster”.

Step 4

On the new B-Master, select and delete the page number text frames.
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In the Pages panel, select the top [None] master page, and choose Apply Master to Pages from the panel’s 
drop-down menu.

We want to have no master applied to the front and back cover of our zine, which is on pages 1 and 10 of our 
document. So type in 1, 10 and click OK.

Step 5

Select the B-Master icon in the Pages panel, and, as before, choose Apply Master to Pages. You want to apply 
the B-Master to any pages which you don’t want to have page numbers. In this case, I type in 2, 6, before 
clicking OK.
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In this zine, I want to split the document into two sections, with page 1 beginning on what is currently page 3 
of the document.

To begin a new section, Right-Click on the page you want to start as page 1 (in this case page 3), and choose 
Numbering & Section Options.

Step 1

3 HOW TO SECTION YOUR ZINE
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In the New Section window that opens, check Start Page Numbering at, and set this to 1.

Step 2

Then click OK. You’ll get a warning message, but don’t worry about that. Just click OK.
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Step 3

On the first page of the document, Right-Click > Numbering & Section Options.

As before make sure Start Page Numbering at is selected and set to 1. But this time choose a different Style for 
the Page Numbering, such as lowercase roman numerals. Then click OK.
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HOW TO CREATE A FRONT COVER  
FOR YOUR ZINE

Working on the first page (i) of your document, and on the Color layer, use the Rectangle Tool (M) to create a 
shape across the whole page, extending the edge up to the bleed on the top, right and bottom sides.

Set the Fill Color to Gradient Swatch.

Step 1

4

You can adjust the strength of the gradient from the Gradient panel (Window > Color > Gradient).  
Here I want to make the gradient blend more abruptly in the center of the page.
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Copy and Edit > Paste in Place the rectangle shape, adjusting the Fill to your blue swatch, C=96 M=82 Y=3 K=0.

Step 2

With the blue shape selected go to Object > Effects > Transparency, and bring the Opacity down to 30%.
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Click on Inner Glow in the panel’s left-hand menu. With the Mode set to Normal, click on the colored square 
to adjust the Effect Color to your red swatch, C=0 M=86 Y=89 K=0.

Increase the Opacity to 100%.

Set the Source to Centre, Size to around 55 mm, Choke to 50% and Noise to about 45%. Then click OK.
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Working on the Type layer, use the Type Tool (T) to add text to your cover, setting the Font to Cormorant and 
Font Color to [Paper].

Step 3
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Select both rectangle shapes sat on the Color layer on the front cover, and Copy them.

Scroll down to the first inside spread of your zine, and Paste the shapes, moving them over onto the left-hand 
page.

Step 1

5 HOW TO BUILD UP CONTENT ON  
THE INSIDE PAGES OF YOUR ZINE
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Edit > Paste a second time, and with this copy selected, go to Object > Convert Shape > Ellipse.

Step 2

From the top Controls panel adjust the Width and Height of the circles to 108 mm.
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Then move these over the top of the left page, positioning them centrally. Shift the top circle slightly up and to 
the right to create a slightly blurry effect.

You can add text to your zine using the Type Tool (T), and working on the Type layer.

Here, I’ve added text set in Cormorant and a blue, C=96 M=82 Y=3 K=0, Font Color, to the righthand page of 
the spread.

Step 3
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Use the Rectangle Frame Tool (F) to create image frames on some of the pages of your zine.

Go to File > Place to drop images into the frames.

Step 4

Use the swatches you’ve already created to format text, adding a touch of color to your typography.

Here, I’ve also set the text to Align towards spine (which you can find in the top Controls panel with the Type 
Tool selected).

Step 5
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Use elements you’ve already created, such as the colored rectangles and circles on the first spread, to create a 
quick and simple design for your back cover, on the final page of the document.

Make sure to add your website to the back cover too.

Step 6
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File > Save your artwork, then go to File > Export.

Choose Adobe PDF (Print) from the Format menu, name your file, and then click Save.

Step 1

6 HOW TO EXPORT YOUR ZINE FOR PRINT
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In the Export Adobe PDF window, choose Press Quality for the Adobe PDF Preset, at the top.

Make sure the pages are set to Export As: Pages (not spreads).

Step 2

Click on Marks and Bleeds in the left-hand menu. Check All Printer’s Marks and Use Document Bleed Settings, 
before clicking Export.

You can send off this PDF document straight to the printers, great job!



SRO DEGREE

Common Maintenance 
Problems

Lesson: pg 147-149 | Handout: pg 150
45 MINUTES
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1.	 Opening and Introductions

2.	 Case Study and Discussion

3.	 What maintenance and repairs are your landlord responsible for? What are tenants 
responsible for?

4.	 Building a case and requesting repairs

Common Maintenance Problems:  
Track them and gather evidence

Topics

Total Time

4 Minutes

OPENING AND INTRODUCTIONS:

Course objectives:

•	 Define which maintenance problems are the responsibilty of the 
landlord and which are the responsibility of the tenants

•	 Learn strategies for getting your landlord to deal with repairs and 
maintenance in a timely manner

•	 Protecting yourself from retaliation and eviction

1 Section Time

5 Minutes

Presenter(s)

_________

CASE STUDY AND DISCUSSION:

Kelly rents a small room in an SRO for $450/month. One day the roof 
starts leaking into Kelly’s room. His bed is soaked and his belongings are 
going  to get moldy. 

Later that day, Kelly calls his landlord to fix his roof. Unfortunately the 
landlord doesn’t answer the phone. Kelly leaves a message but doesn’t 
hear back. The situation is desperate so Kelly calls his landlord again the 
next day and still cannot get a hold of him.

Ask the group:
•	 What should Kelly do first?
•	 What does he need to prove?
•	 What kind of evidence does he need?
•	 What can happen if he doesn’t collect evidence?

2 Section Time

15 Minutes

Presenter(s)

_________

Equipment 
& Materials:

Markers
Flip chart

Photocopies of 
handout

P
P

P
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Landlord Responsibilities:

•	 heating;
•	 plumbing;
•	 electricity;
•	 locks;
•	 light fixtures in common areas;
•	 walls, floors, and ceilings;
•	 fire doors and fire escapes;
•	 smoke alarms;
•	 intercoms;
•	 elevators;
•	 painting at reasonable intervals;
•	 routine yard maintenance, such 

as cutting grass and clearing 
snow, in multi-unit residential 
complexes;

•	 infestations and pests, such as 
bed bugs;

•	 serious mold issues;

Anything included in your tenancy 
agreement, such as the:
•	 fridge
•	 stove
•	 laundry facilities
•	 security system
•	 furniture
•	 garage
•	 storage facilities

Repairs are considered Emergency 
if health and safety of the building 
and property are at risk. 

This includes situations like:
•	 Major leaks in pipes or roof
•	 Damaged plumbing fixtures
•	 Problems with the primary 

heating system
•	 A malfunctioning electrical 

system
•	 Damaged or defective locks 

that make the unit insecure

WHAT MAINTENANCE AND REPAIRS ARE LANDLORDS AND 
TENANTS RESPONSIBLE FOR?

•	 Brainstorm repair and maintenance issues. 
	o write all the issues on a flip chart. 
	o circle the ones that are the landlord’s responsibility
	o add any missing issues

3 Section Time

10 Minutes

Presenter(s)

_________

Lists of Responsibilities from:  
https://tenants.bc.ca/your-tenancy/

repairs-and-maintenance/

Tenant Responsibilities:
•	 reasonable maintenance of carpets during the tenancy;
•	 steam cleaning or shampooing the carpets at the end of 

tenancies lasting one year or longer;
•	 steam cleaning or shampooing the carpets at the end of 

tenancies of any length involving pets or smoking;
•	 cleaning marks on the walls;
•	 removal of garbage from the rental unit;
•	 replacing light bulbs;
•	 routine yard maintenance, such as cutting grass and clearing 

snow, if you have exclusive use of the yard;
•	 minor mold issues; and
•	 repairing excessive damage from nail holes.
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BUILDING A CASE AND REQUESTING REPAIRS:

When any repair needs to be done, you should take photographs, and 
make written notes describing the issue, the date and any attempts you 
have made to contact the landlord. This evidence can help you if your 
landlord does not respond and you need to go to the Residential Tenancy 
Board

From TRAC (Tenant Resource & Advisory Centre):
•	 When something needs to be fixed in your rental unit, let your 
landlord know in writing as soon as possible. 

•	 If you delay and the problem gets worse, you could be held 
responsible for at least some of the associated costs – even if the 
original problem was not your fault. 

	o For example, if you do not immediately report bed bugs and 
the infestation spreads, you may have to pay for at least some 
of the treatment.

4 Section Time

15 Minutes

Presenter(s)

_________

REGULAR REPAIRS:

•	Tenants need to request repairs 
in writing and keep a copy for 
themselves. The document should 
clearly describe the problem and 
must allow the landlord a reasonable 
amount of time to fix it.

•	If no one is available to witness 
you deliver notice to your landlord, 
consider taking a photo or video of 
yourself delivering the letter. 

•	If the landlord doesn’t make the 
repairs, you may apply for dispute 
resolution to request an order the 
repairs to be made, for money to cover 
the inconvenience, or both. 

•	You cannot make the repairs yourself 
and charge the landlord for the costs 
unless you have the landlord’s written 
agreement!

EMERGENCY REPAIRS

If there’s no response from your landlord after two attempts 
to contact them and a reasonable amount of time has 
passed, you can contact the Residential Tenancy Board to 
have them force the landlord to make repairs. (We will go 
over this process in the module “Take Your Landlord to 
Housing Court.”) 

If you can gather funds, you can arrange to have emergency 
repairs done at a reasonable cost. 

Steps to get reimbursed:
•	 First you must submit receipts to you landlord, along 

with a written summary of what happened
•	 If this procedure is followed and the landlord does not 

cover the expenses, you can deduct the repair costs 
from the rent.

Your landlord CAN serve an eviction notice for unpaid rent if 
they claim that:
•	  the costs were too high OR
•	 the repairs were unnecessary OR
•	 you caused the problem that needed to be repaired

This is why documentation is so important!



NOTE: Customize this template to fit your needs before signing and sending it to your landlord. If you are not using registered mail, try to bring

someone – ideally, not a roommate or family member – to witness the delivery of the letter and sign the copy you keep, indicating the date and

method of service. If no one is available to join you, consider taking a photo or video of yourself delivering the letter. Signed letters to your

landlord, along with proof that they were served properly, can be valuable evidence at Residential Tenancy Branch dispute resolution hearings.

Repairs and Maintenance
Date: ____________________

Tenant's Name: ____________________________

Tenant’s Address: 

_________________________

_________________________

_________________________

Landlord’s Name: ____________________________

Landlord’s Address: 

_________________________

_________________________

_________________________

Dear ______________________, [landlord name]

This letter serves as a written request for the following repair(s):

[describe repairs]

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

Section 32(1) of the Residential Tenancy Act states:

(1) A landlord must provide and maintain residential property in a state of decoration and repair that

(a) complies with the health, safety and housing standards required by law, and 

(b) having regard to the age, character and location of the rental unit, makes it suitable for occupation by a tenant. 

I am hopeful that we can resolve the above issue before _________________________  [reasonable date]. If not, I have the 

right to apply for dispute resolution through the Residential Tenancy Branch (RTB) to ask for a repair order and monetary 

compensation.

For additional information, please refer to RTB Guideline 1 – Landlord and Tenant Responsibility for Residential Premises or 

contact the RTB (gov.bc.ca/landlordtenant) at 604-660-1020 or 1-800-665-8779.

Thank you,

_________________________________

                                       [Signature]

Tenant's Name: ______________________



SRO DEGREE

Writing a Letter to 
Your Landlord

Lesson: pg 152-155 | Handouts: pg 159-159
55 MINUTES
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1.	 Why is it important to write letters to your landlord?

2.	 When should you write a letter to your landlord?

3.	 Who do you write the letter to?

4.	 What goes in the letter?

5.	 Where to send the letter?

Writing a Letter to Your Landlord

Topics

Total Time

55 Minutes

WHY IS IT IMPORTANT TO WRITE LETTERS TO YOUR LANDLORD?

Ask the group: why is writing letters so important?

Add or Emphasize:

•	 Writing a letter proves that you tried to fix the problem

•	 Tenants have the legal responsibility to notify the landlord when 
there are problems

•	 You might be able to resolve the issue without going to court

•	 Letters are a great form of evidence that a problem is happening

•	 Letters that are dated can help a judge decide when the problem first 
started

•	 Compensation for a problem could be backdated to the time when a 
letter was first written.  

•	 Copies of these letters could be sent to decision makers like city 
inspectors, head offices of management companies, BC Housing etc.

1 Section Time

10 Minutes

Presenter(s)

_________

Equipment 
& Materials:

Laptop
Projector

Photocopies of 
handouts

P
P

P
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WHEN SHOULD YOU WRITE A LETTER TO YOUR LANDLORD?

Ask the group: when should letters be written?

Add or Emphasize:

•	 When you first notice the problem

•	 Another letter when something changes like the problem gets worse 
or is fixed.  

If you don’t contact your landlord immediately after noticing the problem 
and the problem gets worse, you could be held responsible for at least 
some of the associated costs – even if the original problem was not your 
fault. 

2 Section Time

5 Minutes

Presenter(s)

_________

WHO DO YOU WRITE YOUR LETTER TO?

Ask the group: who should you write to?

Add or Emphasize:

•	 Building Manager

•	 Owner

•	 Board of Directors

•	 BC Housing property portfolio manager

•	 CC:  what does it mean?

If you don’t know your landlord’s legal name and address you can:

	o  give them a letter asking for that information  
(Review TRAC template for Landlord Name and Address)

	o Do a Title and company search 
(Review TRAC handout “Looking Up My Landlord”)

3 Section Time

10 Minutes

Presenter(s)

_________

 
Remember 

to keep a copy 
for yourself of any 

letters you give 
or send to your 

landlord!
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WHAT GOES IN YOUR LETTER? 

Scenario:  

You see a lot of new people in your hallway outside your apartment. 
They are noisy and rude to you when you tell them to be quiet and leave. 
There have been 3 or 4 burglaries in your building. You complained to 
the staff about the people in the hallways and your fear that they are 
responsible for the burglaries.The staff have not done anything to change 
the situation.

What do you put in the letter?

•	 Date

•	 Landlord’s address (title and company searches, board of directors)
o   i.e.  BC Housing:  Who is the property portfolio manager for 
your building?

•	 Write about the facts, not opinions or things you heard:
o   I see people in the hallways and stairwells
o   One time I saw them using drugs
o   Sometimes they leave needles on the stairs
o   I have asked the staff help fix the problem but the problem is 
not fixed
o   One time you walked by people in the stairwell and they 
told you to go away.
o   There have been burglaries. 

•	 Examples of opinions:
o   Drug users are dangerous
o   They are using drugs all the time
o   These people caused a burglary
o   The staff are lazy and don’t care

•	 Say that you will give them a reasonable time to fix the problem and 
if the problem is not fixed then you go to housing court. 

•	 Quote the law – Look at the TRAC website for letter templates
o   https://tenants.bc.ca/resources/template-letters/o   Fill it out 
together with the overhead projector

4 Section Time

15 Minutes

Presenter(s)

_________

 
Who can help 

you write letters in the 
neighbourhood? 

◦ Carnegie Learning Centre ◦
◦ First United Advocacy ◦

◦ DTES SRO Collaborative ◦
◦ TRAC templates online ◦
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WHERE AND HOW DO YOU SEND YOUR LETTER?

Distribute TRAC Serving Documents handout

What does “serving a document” mean?  
•	 Formally delivering a legal document to someone. 
•	 There are different timelines for different methods of delivery.  
•	 Your landlord has to follow the same rules.

What if you or your landlord do not follow the service rules?  
•	 The documents can be dismissed or not regarded. 

METHODS 
Most documents can be served in any of the following ways:

•	 leaving a copy directly with the person
•	 leaving a copy at the person’s residence with an adult who appears 
to live there
•	 leaving a copy with the landlord’s agent
•	 sending a copy via regular or registered mail to the person’s 
residence, or landlord’s business address leaving a copy in the 
person’s mail box or mail slot
•	 attaching a copy to the door or other obvious space at the person’s 
residence, or a landlord’s business.
•	 fax

What methods are not allowed?
•	 Verbally giving information
•	 Text message
•	 Email
•	 Sliding a notice under a door

PROOF OF SERVICE
Witness

•	 Witness should not be a co-tenant or family member
•	 Witness could sign a letter saying the time, date, how it was 
served, who it was served to etc. 

Register mail it from the post office to your landlord’s home or office

If you are alone, you could take a photo of yourself handing the letter to 
your landlord

5 Section Time

15 Minutes

Presenter(s)

_________



NOTE: Customize this template to fit your needs before signing and sending it to your landlord. If you are not using registered mail, try to bring 
someone – ideally, not a roommate or family member – to witness the delivery of the letter and sign the copy you keep, indicating the date and 

method of service. If no one is available to join you, consider taking a photo or video of yourself delivering the letter. Signed letters to your 
landlord, along with proof that they were served properly, can be valuable evidence at Residential Tenancy Branch dispute resolution hearings. 

 

Landlord’s Legal Name and Address 
 
Date: Insert Date Here 
 
Tenant's Name: Insert Your Name 
 
Tenant’s Address:  
Insert Street Address 
Insert City, BC 
Insert Postal Code 
 
Landlord’s Name: Insert Your Landlord's Name 
 
Method of delivery: Describe how you are giving this letter to your landlord (i.e. email, in person, etc.)   
 
Dear Insert Your Landlord's Name,  
 
Section 13 of the Residential Tenancy Act (RTA) requires that landlords include their legal name and an address for service in 
the tenancy agreement. Please provide me with this important contact information, as it is not included in my current 
agreement.  
 
If you are unwilling, I have the right to complete a land title search and apply for dispute resolution at the Residential Tenancy 
Branch (RTB) to recover the associated costs from you. I also have the option to apply for an RTB order that you disclose this 
information and reimburse me for the cost of the dispute resolution application fee. 
 
For additional information, please contact the RTB (gov.bc.ca/landlordtenant) at 604-660-1020 or 1-800-665-8779.  
  
Thank you, 
 
                                         [Signature] 
 
Tenant's Name: Insert Your Name 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 



Looking Up My Landlord

The Basics

Tenancy Branch’s dispute resolution service, you will need to list your landlord’s legal name on 
the application, and serve them with the hearing documents. If you know your landlord’s email 

tact information. See TRAC’s template letter, Landlord’s Legal Name and 

 

Completing a Land Title Search

 Get the property’s nine

property, the PID number should be listed under “Legal description and parcel ID”.

 



Land Title Offices in BC

• New Westminster Land Title Office
–

• Kamloops Land Title Office
–

• Victoria Land Title Office
–

If you are mailing your request, you’ll need to complete and send the

MyLTSA

To complete a land title search online, you’ll need to first

 



Land Title Offices in BC

• New Westminster Land Title Office
–

• Kamloops Land Title Office
–

• Victoria Land Title Office
–

If you are mailing your request, you’ll need to complete and send the

MyLTSA

To complete a land title search online, you’ll need to first

 

Serving Documents 

 

The Basics
Residential Tenancy Act (RTA)

landlords can give, or “serve”, forms and notices to each other. When it comes to providing your 

 In person:

 Post the notice: You can attach your written notice in a visible spot at your landlord’s home, or 

landlord’s door. If possible, bring a witness so you have proof that your notice was served 

your witness sign it. Do not slide the notice under your landlord’s door. The RTA

 Mailbox or Mail Slot:
landlord’s home, or the place where they carry out business as a landlord. If possible, bring a 

RTA

 Fax: 

RTA

 Mail:

RTA

Proof of service: 

Canada Post; or if you post a notice on your landlord’s door, consider taking a
l Claims “Certificate of 

Service” form
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1.	 What to do when your landlord ignores you?   

2.	 What is the city responsible for?   

3.	 How to alert the city to a problem

4.	 What happens at an inspection?

5.	 How to use 311 as evidence

City and Inspections

Topics

Total Time

45 Minutes

WHAT TO DO WHEN YOUR LANDLORD IGNORES YOU?  

WATCH/READ TOGETHER:

•	 http://www.cbc.ca/news/canada/british-columbia/vancouver-re-
gent-hotel-tenants-1.3346199 ( VIDEO 2:31)

•	 http://globalnews.ca/news/2369463/outrage-mounts-over-vancou-
ver-sro-thats-been-without-heat-for-weeks/

•	 http://globalnews.ca/news/2368340/update-city-says-services-at-li-
on-hotel-restored-tenants-claim-otherwise/

You wrote a “request for a repair” letter to your landlord and they failed 
to make a repair in a “reasonable” amount of time.  

ASK THE GROUP: how can you go over your landlord’s head?  

1 Section Time

 10 Minutes

Presenter(s)

_________

Equipment 
& Materials:

Laptop
ProjectorP
P
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WHAT IS THE CITY RESPONSIBLE FOR?  

The Single Room Accomodation (SRA) Bylaw requires the City of 
Vancouver to inpect SROs annually to make sure they are following the 
“Standards of Maintenance” Bylaw.

The Standards of Maintenance Bylaw requires landlords to keep their 
buildings in “good repair”, which includes 

•	 heating systems

•	 plumbing systems

•	 electrical systems

•	 fire safety

•	 pests 

If your landlord is violating the “Standards of Maintenance” Bylaw, you 
can make a complaint and have the city come and inspect your building. 

Alternatively, the bylaw could be used as evidence for a repair order at a 
Residential Tenancy Branch (RTB) dispute resolution hearing.

The city has the power to order your landlord to follow the law and to 
impose fines between $500 and $10,000 if they do not comply.

2 Section Time

10 Minutes

Presenter(s)

_________

HOW TO ALERT THE CITY TO A PROBLEM:

You can contact the city by:

•	 311 online
	o Go to the City of Vancouver 

website and walk through the 
steps for this process

•	 Make a call to 311

3 Section Time

5 Minutes

Presenter(s)

_________ 
Email is 

best so that you 
have a record to 

keep!
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WHAT HAPPENS AT AN INSPECTION? 

•	 How long do you wait for an inspector to come?
	o If the City decides that your issue calls for an inspection, they 

will try to schedule an inspection within a week.

•	 Does the inspector talk to the tenant?
	o ________________________________

•	 Can you ask the city to make sure you are home when the inspector 
comes?

	o ________________________________

•	 Does the tenant get a copy?  
	o ________________________________

•	 San Francisco (I don’t know the specifics of what this is supposed to 
cover)

	o ________________________________

•	 Are you anonymous?
	o ________________________________

Ask the group: what can go wrong with an inspection?

Add or Emphasize:
	o Backlash from manager after you complain
	o Manager goes to your room with inspector
	o Inspector gets you evicted because of problems
	o Inspector can abandon you, not call you back etc.

4 Section Time

10 Minutes

Presenter(s)

_________
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Section Time

10 Minutes

HOW TO USE 311 AS EVIDENCE:

•	 If your landlord still hasn’t fixed the problem after you reported 
them to the city, you may want to apply for Dispute Resolution (next 
module). 

•	 Documenting your complaint to the city/311 can be useful evidence 
when taking your landlord to housing court.

•	 You can also look up other maintenance, health and safety issues 
that have been reported for your building on the Rental Standards 
Database http://app.vancouver.ca/RPS_Net/search.aspx

•	 You can browse buildings with current 
issues or search for your building

	o Go to website and show examples 
on projector

To use your city report as evidence:

•	 Record the date and time of your 
interactions with city inspectors

•	 Get a Tracking #

•	 Print out the email reply

•	 Freedom of Information (FOI) the city – 
look on the website

5 Presenter(s)

_________
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1.	 Resolving issues without going to court

2.	 Going to court

3.	 What if you lose?

4.	 Who can help you

Take Your Landlord to Housing Court

Topics

Total Time

65 Minutes

RESOLVING ISSUES WITHOUT GOING TO COURT  

It is your responsibility to show that you tried to fix the problem by 
communicating with your landlord BEFORE contacting the RTB. 

The following list is suggestions about how to proceed when you find a 
problem. 

Note: If your problem is serious you may decide to write a letter right 
away rather than meet informally.

The Relationship Approach
•	 Build a good relationship from the beginning. Example: Showing 
the landlord that you are taking care of the unit, being friendly when 
you see them, being a good neighbour, be courteous with regards to 
noise late at night, etc…
•	 Ask to meet with your landlord and discuss your hopes to resolve 
these issues between the two of you
•	 Write/date a letter to your landlord asking for assistance with your 
problem
•	 Write/date a letter asking for assistance again but also include a 
quote from the RTA
•	 If the issue still hasn’t been resolved at this point it may be best to 
contact the City and/or the RTB.

Ask the group: what are some reasons we may try to speak to the 
landlord informally before reporting to the city or RTB?

Add or Emphasize:
•	 Making an email 311 report to city hall is seen as aggressive (landlord 

backlash at a later date) 
•	 Housing court is long and stressful and can make things worse 
•	 Risks of RTB:  you don’t always get the results that you want

1 Section Time

15 Minutes

Presenter(s)

_________

Equipment 
& Materials:

Laptop
Projector

Photocopies of 
handouts

Pens
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GOING TO COURT

What is the RTA?  

•	 The Residential Tenancy Act is the set of laws that govern residential 
tenancy in BC

What is the RTB?

•	 The Residential Tenancy Branch is the body that enforces the RTA

The RTB has the power to:
•	 order your landlord to follow the law;
•	 order your landlord to pay you money, or “damages”;
•	 order your landlord to repair your rental unit;
•	 prevent your landlord from entering your rental unit;
•	 give you permission to change your locks;
•	 give you permission to withhold money from future rent 

payments; and
•	 cancel an eviction notice that your landlord has given you.

Where are the RTB offices?  

•	 400 - 5021 Kingsway  
A drop-box at the Burnaby RTB Office is available to submit paper 
applications, evidence and payment. Notice of Dispute Resolution 
Hearing packages can be picked up in person at the Burnaby RTB 
Office and kiosks are available for self-service.

•	 390 Main Street Entrance is on Hastings Street 
DUE TO COVID CLOSED UNTIL FURTHER NOTICE 
Our community outreach office provides limited services for in-
person visits. Staff are able to provide information or assist with 
completing application forms. Please arrive at least 60 minutes before 
closing so that there’s enough time to answer your questions.

2 Section Time

30 Minutes

Presenter(s)

_________
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What is a Dispute Resolution Hearing?

The Residential Tenancy Branch (RTB) offers a service called dispute resolution, which is essentially BC’s 
tenant-landlord “court”. 

When facing a legal problem with your landlord, you can request that a RTB arbitrator look at your case 
and make a legally-binding decision. 

Almost all legal disputes between tenants and landlords must be resolved through the RTB dispute 
resolution system.

Ask the group: has anyone done one before?

7 part process

1.	 Application 
	o fill it out together; 
	o proof of income; 
	o fee waiver

2.	 Service 

Once your dispute resolution application has been accepted, the RTB will provide you with 2 packages 
- one for you, one for your landlord. The package lists the date and time of your hearing, instructions 
on how to prepare for your hearing, and copies of the application and submitted evidence.

	o You have 3 days to serve these documents to your landlord; 
	o role play service, importance of a witness; 

3.	 Evidence 

	o review “Preparing for a Hearing” TRAC handout (including Monetary Order Form)

4.	 Serving

	o If you haven’t served all your evidence with your application, you must submit it at least 14 
days before the hearing. Evidence should always be submitted as soon as possible, because 
have the right to refuse evidence that was intentionally submitted later than it could have been. 
Evidence must also be served to your landlord. 

5.	 Hearing
	o review “Participaing in a Hearing” TRAC handout 

and/or 
	o watch TRAC video: https://www.youtube.com/watch?v=sUVCZNzkMXE - 

START 53:05 | END 1:07:40

6.	 Decision 
	o review sample decision

7.	 Serving (I DONT KNOW/CAN’T FIGURE OUT THE DETAILS OF THIS.... )
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WHAT IF YOU LOSE?

If you lose you might be able to apply for Review Consideration of the 
decision

To apply you must meet one of the following reasons:

•	 You could not attend the hearing due to unforeseen circumstances

•	 You have new and relevant information that was not available at the 
time of your hearing

•	 You have evidence that the decision was obtained by fraud

Important information about your application:

•	 The Review application form must be submitted in person at a Service 
BC Centre that accepts RTB forms or the Burnaby Residential Tenancy 
Branch office.

•	 The form requires a $50 filing fee. (or a fee waiver application)

•	 A copy of the decision or order must be included with this application

After you receive a decision or order, you must submit the application 
within:

•	 Two days if related to an early end of tenancy, an order of possession, 
unreasonable holding of consent for sublet or assignment or a notice 
to end tenancy for unpaid rent

•	 Five days if related to a notice to end tenancy for any other reason 
(other than unpaid rent or utilities), for repairs or maintenance, or 
services or facilities

•	 Fifteen days if related to any other part of the Residential Tenancy Act 
or Manufactured Home Park Tenancy Act not listed above

You may request an extension of the deadline due to unforeseen events, 
with supporting evidence

Review the Application for Review Consideration  

3 Section Time

15 Minutes

Presenter(s)

_________
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WHO CAN HELP? 

Review “Help with Housing and Landlord Problems” handout

Ask the group: do you know of any others?  

4 Section Time

5 Minutes

Presenter(s)

_________

HANDOUTS:

Tenant Application for Dispute Resolution (10 pages)

Application to Waive Filing Fee (2 pages)

Preparing for a Hearing handout (3 pages)

Sample Decision (5 pages)

Application for Review Consideration (4 pages) 

Finding Help With Housing & Landlord Problems (1 page)



Residential Tenancy Branch 

Tenant  Application for Dispute 
Resolution Current Tenancy

 #RTB- 12T-CT

How to use this form:

Important information about your application:

You must be able to serve documents to your landlord(s).

Form Sections



Residential Tenancy Branch 

Section 1: Key Dispute Information 

(Do not use this form, use RTB 12T-PT)

Rental Unit  Address:

Primary : (This main contact responsible for serving documents on all parties. The
Residential Tenancy

Section 2: Second  



Residential Tenancy Branch 

Section 3: Respondent Information

Second Respondent Information ( )

Section 4: Tenant Issues: (select all that apply) Common Requests to Cancel Notices to End a Tenancy

I received a 10 Day Notice to End tenancy for unpaid rent and/or utilities



Residential Tenancy Branch 

Section 4: Tenant Issues: (select all that apply)

I received a One Month Notice to End Tenancy for Cause (See section 5 for One Month Notice to End
Tenancy for End of Employment)



Residential Tenancy Branch 

I received a Two Month Notice to End Tenancy for Landlord’s Use of Property 
(See section 5 for Two Month Notice to End Tenancy for a tenant who doesn’t qualify for subsidized housing)



Residential Tenancy Branch 

Other Issues: (select all that apply)

I want the landlord to comply with the Act, Regulations, or tenancy agreement

I want compensation from the landlord for 
monetary loss under the Act, Regulations or 
tenancy agreement



Residential Tenancy Branch 

I want the Landlord to make repairs, that I requested in writing

I want to reduce rent for repairs, services, or 
facilities agreed upon but not provided

I want to suspend or set conditions on the Landlord’s right to enter the rental unit or site

I want the Landlord to provide services or facilities required by the tenancy agreement, Act or 
Regulations



Residential Tenancy Branch 

Section 5: Other Tenant Issues: Other Notices to End Tenancy that I am Requesting to Cancel



Residential Tenancy Branch 

General Issues:

 including form #RTB 12T- O



Residential Tenancy Branch 

Section 6: Declaration: 

Residential Tenancy Branch Contact Information

Lower Mainland

Outside of Lower Mainland  



Application to Waive Filing Fee  
 #RTB- 17

Residential Tenancy Branch 

Why are you applying for a fee waiver? (select one)

Section 1: Applicant Information 

How to use this form:

Important information about  application:

Household size:

Monthly income:
Proof of income
Extraordinary expenses:

Form Sections:



Section 2: Household and Income Information (as a landlord you must include your rental income in the section)

Income Information: (please select the documents you are providing with this application)

Section 3: Declaration: 

Residential Tenancy Branch Contact Information

Lower Mainland

Outside of Lower Mainland  



Preparing for a Hearing 
(from TRAC |   https://tenants.bc.ca) 

 

 ​The Basics 
To be successful at dispute resolution, you will have to gather and submit enough quality evidence to 
convince an arbitrator to rule in your favour. Telling your side of the story is generally not enough; you 
should be prepared to present relevant evidence in a convincing manner. 

 
 

 ​Gathering and Submitting Evidence 

Here are some examples of evidence that you should consider submitting: 

● Tenancy agreement: Your landlord is legally required to give you a copy of your tenancy 
agreement within 21 days of entering into your tenancy. 

● Written communication: Include written communication that strengthens your case, such as 
letters, forms, and notices. Relevant emails, texts, and social media messages may also be 
considered by arbitrators. 

● Photos: Add descriptions of the photos and when they were taken. You should number and 
label them in a consistent fashion – for example, “Living Room Photo 1” and “Living Room 
Photo 2”. 

● Audio and video recordings: Indicate which parts of the audio recordings and videos you would 
like the arbitrator to listen to and watch. 

● Witnesses: Have witnesses speak at the hearing or submit signed witness statements. 
● Affidavits: Submit affidavits (sworn statements) signed by you or your witnesses. A lawyer, 

Notary Public, or Commissioner of Oaths can assist you with this process. Affidavits may cost 
money but are generally considered stronger evidence than unsworn statements. 

● Receipts: You will need proof of the expenses you paid when seeking a monetary order. 
● Monetary Order Worksheet: If you are applying for a monetary order, you must submit the 

Residential Tenancy Branch form, “Monetary Order Worksheet”. 
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Deadlines to Submit Evidence 
All evidence that you want to rely on at dispute resolution needs to be submitted to the Residential 
Tenancy Branch (RTB) and properly served on your landlord. 

The person applying for dispute resolution – the “applicant” – should do their best to submit evidence 
with their application. If that is not possible, the RTB and the respondent must receive the evidence at 
least ​14 days​ before the hearing. Evidence should always be submitted as soon as possible, as 
arbitrators have the right to refuse evidence that was intentionally submitted later than it could have 
been. 

The person responding to the application – the “respondent” – must ensure that all their evidence is 
received by the RTB and the applicant at least ​7 days​ before the hearing. Again, if evidence 
submission is intentionally delayed, the arbitrator may decide to not consider it. 

Late evidence: If you miss the deadline for submitting evidence, you can still submit your evidence 
late. Be prepared to have an argument ready for why the arbitrator should consider the evidence at 
the hearing. For example, the evidence may have only become available after the evidence deadline. 
If your landlord brings up evidence during a hearing that you did not receive on time, you can ask the 
arbitrator to not consider it, or to adjourn (reschedule) the hearing to a later date. See ​section 3.17 ​ of 
the Rules of Procedure for more information. 

Service rules: The way that evidence is served can affect when it is legally considered received. See 
TRAC’s webpage, ​Serving Documents ​, for more information. 

  

 
  

Digital Evidence 
Tenants who have filed for dispute resolution must, where possible, digitally submit evidence to the 
RTB through their online system. If you are not able to upload evidence in this manner, you can still 
submit physical copies directly to the RTB, or to any Service BC Centre across the province. Digitally 
submitting evidence to the RTB will make it available to the arbitrator handling your case, but the RTB 
will not send copies to your landlord on your behalf. This means that, when you digitally submit 



evidence to the RTB, you must also serve copies of that evidence to your landlord using an accepted 
method of service according to the Residential Tenancy Act. 

When submitting digital evidence, you should ensure that your evidence is well organized. According 
to ​section 3.10.1 ​ of the Rules of Procedure, digital evidence should be accompanied by descriptions 
of the evidence, logical numbering systems for photographs, a time code for the key point in any 
audio or video recordings, etc. You must also submit RTB form, “ ​Digital Evidence Details ​”. This form 
will help keep your evidence organized for the arbitrator, and ensure you follow the required steps for 
service. 

When serving digital evidence on your landlord, you must ensure that they are able to access the 
evidence. For example, if you submit video evidence to the RTB online, and then make a DVD of that 
video to serve on your landlord, you must confirm with your landlord that they have playback 
equipment for the DVD, or can somehow access the information on the disc. When asked about 
whether they can access a particular format, your landlord must reply as soon as possible. If you 
choose to submit digital evidence, you must keep exact copies of that evidence for two years after the 
dispute resolution process has concluded. See sections 3.0 and 3.10 of the ​Rules of Procedure ​ and 
RTB ​Policy Guideline 42 ​ for more information. 
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Application for Review Consideration
 #RTB- 2

Residential Tenancy Branch 

How to use this form:

Important information about your application:
•

•
Two days 

Five days

Fifteen days

•
•
•
•

•
• Do not resubmit evidence from the original hearing

Form Sections:



Residential Tenancy Branch 

Section 1: Key Dispute Information 

landlord tenant

Requester Information

Section 2: Grounds for Review: (Select all that apply and provide a brief description of each one)



Residential Tenancy Branch 

Section 2: Grounds for Review (Select all that apply and provide a brief description of each one)



Residential Tenancy Branch 

Section 3: Declaration: 

Residential Tenancy Branch Contact Information

Lower Mainland

Outside of Lower Mainland  

Section 2: Grounds for Review (Select all that apply and provide a brief description of each one)
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SRO DEGREE

Door Knocking & 
Landlord Backlash

Lesson: pg 198-200 | Handouts: pg 192-198
45 MINUTES
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Door Knocking & Landlord Backlash | Pg 198

1.	 Canvassing door-to-door for neighbour support

2.	 How to deal with landlord backlash

3.	 Case study from the West Hotel & Right to Quiet Enjoyment 
in the Law

Door Knocking and Landlord Backlash

Topics

Total Time

45 Minutes

CANVASSING DOOR-TO-DOOR FOR NEIGHBOUR SUPPORT 

Ask the group: why should we get support from neighbours?

Add or Emphasize: 
•	 Safety in numbers
•	 More likely to win in court
•	 You might have common issues
•	 Neighbours can back you up when things go wrong
•	 Witnesses are a type of evidence that you can use to prove a fact.  
•	 You will be happier if you know your neighbours
•	 Power in numbers --- You will have more power for campaigns like no 

heat, rats, violence, personal mailboxes, replacement housing etc.

Ask the group:
Has anyone door knocked?
Has anyone door knocked on a stranger’s door?  
Has anyone ever had someone knock on their door?  

Brainstorm: elements of a Successful Door Knock

Write all ideas on flip chart, then distribute “Elements of a Successful 
Door Knock” handout and compare with what the group came up with

1 Section Time

20 Minutes

Presenter(s)

_________

⇨Activity next page

Equipment 
& Materials:

Markers
Flip chart

Photocopies of 
handouts

P
P

P
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Door Knocking & Landlord Backlash | Pg 199

2 ROLE PLAYS
Based on the brainstorm get volunteers to demonstrate:

1) BAD EXAMPLE – the door knock goes badly and doesn’t include all the elements of a good door knock 

Discuss: Was it effective? (No) Why not?

2) GOOD EXAMPLE – goes well and all the elements of a door knock are in place

Discuss: Was it effective? (Yes) What made it effective?

LANDLORD BACKLASH

Ask the group: what kinds of landlord backlash have you experienced?

•	 What can you do if your landlord is harassing you?

•	 How can you use the Residential Tenancy Branch to stop landlord 
backlash?

•	 How many people here have experienced or seen cases of landlord 
backlash?   What are some examples?   Why do landlords do this?  
What did you do to stop it?  

Things you should do if your landlord is harassing you:

•	 If not criminal, then write them a letter and ask them to stop

•	 Serve the letter properly

•	 Keep a copy of the letter

•	 Call 911 or non emergency

•	 Ask an advocate for help

•	 Talk to your neighbours to find out if it is happening to them too and 
whether they can be a witness

•	 File and RTB complaint

2 Section Time

15 Minutes

Presenter(s)

_________
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CASE STUDY: DAN AT THE WEST

Complaint about guest fees and no hot water. Physical assault by the 
agent of a landlord

•	 Bogus Eviction notice #1
	o Dan keeps up his complaints
	o Room tossed & laptop smashed

•	 Bogus Eviction notice #2
	o Verbally threatened by agent
	o Dan calls the VPD and keeps a copy of the reports

•	 Bogus Eviction notice #3:  failing to pay rent

•	 Bogus Eviction notice #4:  failing to pay rent

•	 Bogus Eviction notice #5:  ??
	o Dan launches Right to Quiet Enjoyment complaint at the RTB

Decision for $1,200 monetary order for the first 5 bogus evictions 

Small Claims – names all the employees and board of directors. Landlord 
and employees go to Small Claims and try to re-argue the case.  

	o Judge says they are not allowed to do this.  Dan secretly 
laughing. Judge gives them a certain number of days to produce 
all their financial statements, tax returns etc or go to jail.  

	o Landlord pays Dan $6,000 immediately

Owner fires the manager and hires a new management company
	o Read from Dan’s affidavit about the list of things that Dan 

forced the owners and management company to repair

•	 Bogus Eviction notice # 6:  Landlord wants his room
	o Decision to overturn that request
	o Dan wins $1000 compensation for Eviction #6 because of 

harassment under “Right to Quiet Enjoyment” and given the 
number of previous eviction notices

•	 Bogus Eviction notice # 7:  Fire in his room – blame him for damages 
– he can use the $1000 decision to dispute eviction 7 – RTB scheduled 
it far into the future (139 days – longest in RTB history)

	o Administration penalties
	o Dan’s main weapon:  Right to Quiet Enjoyment – Review the 

TRAC handout

3 Section Time

10 Minutes

Presenter(s)

_________

I don’t know if the 
documents I pulled 
are the ones that 
this is referring to.

(Pg 202-203)

It would be great if 
someone can look 
through Brian’s 
scans to see what 
documents are 
relevant to this case 
and which of those 
should be included



 
 
Elements of a Successful Door Knock 

 
• Always keep eye contact  
• Keep your hands visible  
• Body language is key, self-confidence, no crossing arms 
• Knock gently but firm  
• If it’s a general survey: ask the manger or desk clerk to fill out first  
• If you knock and the person is not interested in speaking, leave  
• Introduce yourself always: hi, my name is …. I am from ….. Would like to 

talk to you about …… 
• State the purpose of your door knocking clearly. Say you want a min of 

their time, acknowledge that you know they are busy  
• Engage in the purposeful conversation  
• Be respectful to the person u are talking to  
• If they need follow up.. Make plans to follow up while you are at the door 

or street. 
• If they are not interested in speaking … thank them and leave.  
• Once they heard you or you engaged in conversation, thank them for their 

time.  
• Gather basic information (contact info )  
• Ask them in the end if they can introduce to other tenants they know off.   
• Keep reasonable personal space when you approach people or door knock. 
• Compassion, active listening and don’t react to negativity 

 
Don’t  

 
• No argument – don’t tell people they are wrong  
• Be totally disinterested  
• No introduction  
• Force conversation 
• Be combative 
• Curse  







Quiet Enjoyment 
 

The Basics
Residential Tenancy Act (RTA) covers “quiet enjoyment” –

• 
• 
• 
• 

• 
• 
• 
• 
• 
• 

RTA –

the situation. See TRAC’s template letter,
– –



Landlord Entry
Legal Landlord Entry

– –

• 
• 
• 

Exceptions:

• there is an emergency and the landlord’s entry is necessary to protect life or property;
• 

• 

• the tenant has “abandoned” the rental property, according to Residential 
Tenancy Regulation

Residential Tenancy Act

Illegal Landlord Entry

provide you with proper written notice in the future. See TRAC’s template letter,

• 
• 
• 
• if your landlord’s behaviour is serious enough, order them to pay you monetary 



Noise

–

Smoking

– ou are viewing. Some buildings with “no smoking” policies 

Marijuana:

BC Human Rights Code
must also ensure that they are not violating another tenant’s right to quiet enjoyment un

Residential Tenancy Act



Intimidation, Harassment, and Physical Harm

If your landlord’s behaviour endangers your personal safety, 

Residential Tenancy Act
ending your tenancy early if your landlord has breached a “material term” and failed to correct 

n warning. See TRAC’s 

Calling the police:
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40 MINUTES



VAN CCAPO: Street Degree                                                                                                                           SRO Organizing

Taking Leadership and Illegal Rent Increases | Pg 209

1.	 Taking leadership

2.	 Reclaim money taken in an illegal rent increase

Taking Leadership and Illegal Rent Increases

Topics

Total Time

40 Minutes

TAKING LEADERSHIP

Ask the group: why is it important to talk about leadership?  
•	 We need you all to be leaders in the community!  
•	 Maybe we will set up a union and make demands to our landlords 

and governments
•	 Safety in numbers and Strength in numbers
•	 You can find other leaders in your building to back you up
•	 Watch your back

Ask the group: 
•	 Can you think of a time when you felt as though you were being a 

leader?  Does anyone want to share this with the group? 
•	 What does this word mean?  Does it mean something different to 

everyone?  
•	 Who do you recognize as a leader in your life? 

4 examples of styles of leadership:
•	 Authoritarian – you control everything
•	 Participatory – You work with others and share decision making and 

responsibility
•	 Delegate – You give responsibility to others and check in regularly
•	 Free reign – You give others work without checking in.

How can we identify hidden leaders?
•	 Look to people involved in activities or community organizations
•	 As for commitments and see who steps up
•	 Long-term residents
•	 People who have a lot of friends or who know a lot of people.
•	 People that others respect

1 Section Time

20 Minutes

Presenter(s)

_________

Equipment 
& Materials:

Markers
Flip chart

Photocopies of 
handouts

P
P

P
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HOW TO GET AN ILLEGAL RENT INCREASE BACK FROM YOUR 
LANDLORD

Ask the group: What do you know about rent increases?

•	 Landlords can only raise rents once a year

•	 Rents can only be raised by an amount permitted by law
	o Rent increase calculator  

http://www.housing.gov.bc.ca/rtb/WebTools/RentIncrease.html

•	 Legal form must be used “Notice of Rent Increase” Handout

•	 Tenants must get 3 full months notice of the rent 
increase

	o If your landlord gives you less than three full 
months notice, you can continue to pay your 
current rent until the correct amount of time 
has passed. 

What does the Law say about rent increases?  Read the 
RTA Part 3 “Rent Increases - RTA” Handout

Ask the group: Has anyone experienced an illegal rent 
increase before?  Did you fight it?  If you get an illegal 
rent increase, what could you do?

•	 Find out if anyone else got one in your building

•	 Strength in numbers to avoid landlord backlash!

•	 Talk to the RTB office if you want to go that route 
or get advocate

•	 Write a letter and just deduct payments.

Read a sample letter about rent 
increases.  “Sample Overpayment 
Letter” handout and TRAC letter 
template

2 Section Time

20 Minutes

Presenter(s)

_________

 
Rent raises 

were banned from 
 April 2020 to  

Dec 2020. 

The maximum rate for 
2021 is 1.4%.
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Notice of Rent Increase
– Residential Rental Units

#RTB-7

This form is used by the landlord to notify a tenant of a rent increase. The landlord must give the tenant at least
three months notice. See page 2 for further information.

A.  TO THE TENANT(s):
Full Name(s):

FORM DIRECTIONS: If you are accessing this agreement from the B.C. Government Web site, it can be filled out at the computer workstation.
It can also be printed and completed by hand. If completing sections by hand, please print clearly, using dark ink. If you are completing this form
at a computer, simply type in your response in the boxes. If you cannot complete all the sections at the computer right away, you can print off
what you have completed, and fill in the remaining fields by hand. It’s important to note that you cannot save the completed form to your 
computer, therefore, after you complete the form, make sure you review the form for accuracy and print the number of copies you require before
you leave the document or shut down the program/computer. 

Mailing Address and Phone:

site number        box number        street number     street name

city  province postal code                home phone                             business phone

Rental Address: (if different from above)

B.  FROM THE LANDLORD: (if entry for landlord is a business name, use the ’last name’ field box to enter the full legal business name)
Full Name:

last name first name middle name(s)

last name first name middle name(s)

last name first name middle name(s)

Mailing Address and Phone:

site number        box number        street number     street name

city  province postal code                home phone                             business phone

Residential Tenancy Branch 
Office of Housing and Construction Standards 
#RTB-7 (2011/03)

FOR MORE INFORMATION 
RTB website: www.gov.bc.ca/landlordtenant 

Public Information Lines 1-800-665-8779 (toll-free)    Greater Vancouver 604-660-1020       Victoria 250-387-1602
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INFORMATION FOR LANDLORDS and TENANTS
GIVING A NOTICE OF RENT INCREASE UNDER THE RESIDENTIAL TENANCY ACT (RTA)  

• Once a year, the landlord may increase the rent for the existing tenant.  The landlord may only increase the rent 12
months after the date that the existing rent was established with the tenant(s) or 12 months after the date of the last
legal rent increase for the tenant(s), even if there is a new landlord or a new tenant by way of an assignment.

• A landlord must give a tenant at least 3 whole month's notice, in writing, of a rent increase.  For example, if the rent is
due on the first day of the month and the tenant is given notice any time in January, even January 1st, there must be
3 whole months before the rent increase begins.  In this example, the months are February, March, and April, so the
rent increase would begin on May 1st. The landlord must use this form, Notice of Rent Increase, and must serve
according to the Residential Tenancy Act.  

• It is an offence for a landlord or a landlord's agent to collect a rent increase in any other way other than in accordance
with Part 3 of the Residential Tenancy Act.

• A notice sent by mail (which is one method of service) is deemed to be received on the 5th day after it was mailed.
For example, a rent increase given personally to a tenant on or before January 31st, could be effective May 1st; 
a rent increase given by registered mail should be mailed on or before January 26th for the increase to be effective
on May 1st.

• A tenant may not apply for dispute resolution to dispute a rent increase that complies with Part 3 of the RTA.
• A landlord may only impose a rent increase up to the amount calculated in accordance with the regulations or as

ordered by an arbitrator.  If a tenant believes that the rent increase is more than allowed by the regulations, the tenant
may contact the Residential Tenancy Branch for assistance.

• For further information on rent increases, see Part 3 of the Residential Tenancy Act and Part 4 of the Residential
Tenancy Regulation.  You may also call the recorded 24-hour information line or visit the B.C. Government Web site
to find out how to contact a Residential Tenancy Branch or to get more information (this information is at the bottom of
page 1).

D. LANDLORD’s SIGNATURE: The information provided on this form is true and correct.
Landlord’s Name:

Landlord’s Signature: Date:

C. NOTICE OF RENT INCREASE:

1) Date of Last Rent Increase: (landlord to complete either option a or b)

a) the date your last rent increase came into effect was:
day         month                    year

b) As this is your first rent increase, the date your rent was established:
day         month                    year

2) Amount of Rent Increase: 
• The current rent is:          $                      weekly monthly other:

• The rent increase is $                      weekly monthly other:

• Your new rent will be:  $                         weekly monthly other:

• Your new rent is payable starting on:
day          month                  year

last name first name middle name(s)

(if entry for landlord is a business name, use the ’last name’ field box to enter the full legal business name)

#RTB-7



Meaning of "rent increase" 

40  In this Part, "rent increase" does not include an increase in rent that is 

(a) for one or more additional occupants, and 

(b) is authorized under the tenancy agreement by a term referred to in 

section 13 (2) (f) (iv) [requirements for tenancy agreements: additional 

occupants]. 

Rent increases 

41  A landlord must not increase rent except in accordance with this Part. 

Timing and notice of rent increases 

42  (1) A landlord must not impose a rent increase for at least 12 months after whichever of 

the following applies: 

(a) if the tenant's rent has not previously been increased, the date on 

which the tenant's rent was first established under the tenancy 

agreement; 

(b) if the tenant's rent has previously been increased, the effective date 

of the last rent increase made in accordance with this Act. 

(2) A landlord must give a tenant notice of a rent increase at least 3 months before 

the effective date of the increase. 

(3) A notice of a rent increase must be in the approved form. 

(4) If a landlord's notice of a rent increase does not comply with  

subsections (1) and (2), the notice takes effect on the earliest date that does 

comply. 

Amount of rent increase 

43  (1) A landlord may impose a rent increase only up to the amount 

(a) calculated in accordance with the regulations, 

(b) ordered by the director on an application under subsection (3), or 

(c) agreed to by the tenant in writing. 

(2) A tenant may not make an application for dispute resolution to dispute a rent 

increase that complies with this Part. 

(3) In the circumstances prescribed in the regulations, a landlord may request the 

director's approval of a rent increase in an amount that is greater than the amount 

calculated under the regulations referred to in subsection (1) (a) by making an 

application for dispute resolution. 

(4) [Repealed 2006-35-66.] 

(5) If a landlord collects a rent increase that does not comply with this Part, the 

tenant may deduct the increase from rent or otherwise recover the increase. 

 

 

From the 
Residential 
Tenancy 
Act



Tenant’s name

Tenant’s address

Landlord’s name

Landlord’s company name

Landlord’s address

Date

Dear Landlord,

Can you say something positive about your landlord? Anything to thank them for? A timely repair? If 
yes, say it at the start.

As you know, when you raised the rent $57.00 to $500.00 per month starting August 1, 2015 when I 
got out of the hospital, I requested the appropriate paperwork from you three times and did not receive 
it.

Landlords can only increase the rent once a year by an amount permitted by law. Landlords need to 
use the correct form and give the tenant three full months’ notice prior to the rent increase coming 
into effect. The maximum allowable rent increase changes every year. For residential tenancies, which 
includes Single Room Occupancy Residential Hotels, the standard allowable rent increase for 2015 was 
2.5% and for 2016, it is 2.9%. The rent increase cannot be more than the amount calculated using the 
allowable increase percentage.

These rent overpayments happened from August 01 2015 to Feb 01, 2016:

In accordance with the Residential Tenancy Act SBC 2002, c 78, “if a landlord collects a rent 
increase that does not comply with the Legislation, the tenant may deduct the increase from 
rent.”



This means as of March 01, 2016, I am entitled to deduct the overpayment from my rent. For the next 7 
months starting March 01, 2016, I will be deducting $57.00 per month from $443.00 and therefore will 
be paying $386.00 a month for rent to make up for the 7 months of overpayments. After the 7 months is 
over, I will resume paying  $443.00 which was the rent prior to when the overpayments began.

Months Date of rent payment Rent

((((end on positive note??)))))

I hope to continue your friendly, courteous and respectful relationship.

Sincerely,

Tenant



NOTE: Customize this template to fit your needs before signing and sending it to your landlord. If you are not using registered mail, try to bring someone – 
ideally, not a roommate or family member – to witness the delivery of the letter and sign the copy you keep, indicating the date and method of service. If no 
one is available to join you, consider taking a photo or video of yourself delivering the letter. Signed letters to your landlord, along with proof that they were 

served properly, can be valuable evidence at Residential Tenancy Branch dispute resolution hearings. 

Illegal Rent Increase Notice 
 
Date: ________________ 
 
Tenant's Name: ___________________ 
 
Tenant’s Address:  
___________________ 
___________________ 
___________________ 
 
Landlord’s Name: ___________________ 
 
Landlord’s Address:  
___________________ 
___________________ 
___________________ 
 
Dear : ___________________,  
 
On : ___________________(date), you provided me with an illegal rent increase notice. You have not complied with the Residential 
Tenancy Act (RTA) and I do not consent to this rent increase. I will continue to pay my current monthly rent of : $________________until 
my rent is legally raised in accordance with the RTA. 
 
Section 42 of the RTA states: 
(1) A landlord must not impose a rent increase for at least 12 months after whichever of the following applies: 

(a) if the tenant's rent has not previously been increased, the date on which the tenant's rent was first established under the 
tenancy agreement; 

(b) if the tenant's rent has previously been increased, the effective date of the last rent increase made in accordance with this 
Act. 

(2) A landlord must give a tenant notice of a rent increase at least 3 months before the effective date of the increase. 
(3) A notice of a rent increase must be in the approved form. 
(4) If a landlord's notice of a rent increase does not comply with subsections (1) and (2), the notice takes effect on the earliest date that 

does comply. 
 
Section 43 of the RTA states: 
(1) A landlord may impose a rent increase only up to the amount 

(a) calculated in accordance with the regulations, 
(b) ordered by the director on an application under subsection (3), or 
(c) agreed to by the tenant in writing. 

(5) If a landlord collects a rent increase that does not comply with this Part, the tenant may deduct the increase from rent or otherwise 
recover the increase. 

 
The rent increase notice you have given me violates the above sections of the RTA because : ___________________________________ 
 
To find this year’s allowable rent increase percentage, please see the Residential Tenancy Branch (RTB) website (gov.bc.ca/landlordtenant). 
For additional information, contact the RTB at 604-660-1020 or 1-800-665-8779. 
   
Thank you, 
 
                                [Signature] 
 
Tenant's Name: : ___________________ 
 
 
 

 
 


